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Fundamentals




Notebook Structure

Each page of the Notebook contains a different document. You can have as
many pages in the Notebook as you want (up to the amount of available
memory).

A document can be longer than what you see on the screen. You can bring the
hidden part into view by scrolling. You'll find details in “Scrolling a
Document” in chapter 3 (Creating and Using Documents).

A document can be longer than
what you see on the screen

Tap . the scroll arrows to see the
off-screen portions
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NOTEBOOK STRUCTURE

As in a paper notebook, you can organize the pages by grouping them into
sections. The name of each document and section is listed in the table of
contents, which is on the first page of the Notebook.

To get to a particular document you can turn pages or tap the page number in
the Notebook table of contents. But if it’s a document you use frequently, you
might want to attach a notebook tab to it. Then you can go directly there by
tapping the tab.

Section

Document

To see what’s in the Notebook:

—< Tap the Contents tab to see the
table of contents for the entire
Notebook

4 Tap a notebook tab to go to a
specific document

GO CONFIDENTIAL FUNDAMENTALS
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INTERACTING WITH THE GO COMPUTER

Civing Commands with Gestures and Menus

When you work with the
documents in your Notebook, you:

Choose menu commands.

4 Tap a menu name to open it and
see its choices. Tap again to
choose a command.

4 Dimmed commands are currently
unavailable.

Draw gestures symbols or letters
that tell PenPoint what to do.

4 The gesture profiles in chapter 2
show you how to draw each kind
of gesture.

(If you don’t see the menu line, you may have zoomed the page so that it takes
up the full screen. Draw a flick down | on the title line to restore the page to its

normal size.)
If you choose a command or draw a gestL
by mistake you can often reverse it by
choosing Undo from the Edit menu.
USING THE GO COMPUTER ' GO CONFIDENTIAL
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INTERACTING WITH THE GO COMPUTER

Using the Items on the Bookshelf

The bookshelf holds additional small notebooks and accessories which you use
for different tasks, such as sending and receiving mail. These specialized

notebooks are represented by icons.

%% n S N
R BJRL ey el

This page will be a table— design in
progress

GO CONFIDENTIAL
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The Help notebook gives brief

instructions about how to use the

- GO Computer and PenPoint.

Preferences lets you set options such
as the way icons look and the layout
of the screen.

The Stationery notebook contains
sample documents that you copy to
create new pages in your Notebook.

You use the Installer to add
programs to your Notebook.

Use the Inbox and Outbox to send
and receive electronic mail, faxes,

and files.

The DiskViewer lets you see what’s
on other disks or computers.

You use the Device notebook to set
up printers.

The Keyboard is an on-screen
keyboard that you tap to enter data.

The Accessories notebook contains
things like the clock and
Handwriting Trainer.

FUNDAMENTALS
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INTERACTING WITH THE GO COMPUTER
USING THE ITEMS ON THE BOOKSHELF

+—1—< 1 Tap the icon to open the Help
notebook
—< 2 Tapits close corner to close the
Help notebook again
USING THE GO COMPUTER GO CONFIDENTIAL
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INTERACTING WITH THE GO COMPUTER

Training Fenfoint in your Handwriting

You'll find the Handwriting Trainer in the Accessories icon along with such
things as the clock. You can store other accessories you acquire for the GO
Computer here.

¥ Tap the Accessories icon to open it.

2 Tap Handwriting Trainer {name??}
to turn there.

i , //l‘/‘&%i/ %
?%w// o

3 Follow the instructions on the
screen to practice printing letters
clearly and to teach PenPoint how
you habitually form your letters.

4 To save your handwriting profile,
{222}
4 You can return to the
Handwriting Trainer at any time
to teach PenPoint more about a
specific letter it may translate
incorrectly.

5 > Lo
rded. Tap: ‘Lea‘m to hawe rhc oompu’rer accept gour :
ap "Clear" fo clear a word at’ a time. Tap "Next* “for

GO CONFIDENTIAL FUNDAMENTALS
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INTERACTING WITH THE GO COMPUTER

Using Option Sheets

Option sheets allow you to specify the scope of a menu command or to set
attributes such as a font for text or the icon size for an item on the bookshelf.

You'll often see an option sheet when you choose a menu command that’s
followed by three periods (an ellipsis). Otherwise you ask for one by using
check or the Edit menu.

Option sheets may prompt you for further information before carrying out a
command. For example, if you choose Find, PenPoint asks what you want to
find. You fill in the requested information by writing in a text field or by
choosing options.

Displaying Optibn Sheets

To see the options for:

v Text: Draw a check on selected text. Or, select the text and choose Options
from the Edit menu.

v Documents: Draw a check on the document title in the table of contents.
Or, select the title and choose Options from the Edit menu.

v Bookshelf icons and Goto Buttons: Draw a check on the object.

Sometimes there will be more than one option sheet. An arrow on the title line
indicates there’s more than one.

1 Drawa check on the word to
display the text option sheet

¥ 2 Tap tosee a list of the other option
sheets

‘ gua;ua_. J.

43 Reposition the option sheet by
dragging the gray border

|_4 4 Resize the option sheet by dragging
the bottom handle

Gowviovd |\ yOwiol |
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INTERACTING WITH THE GO COMPUTER
USING OPTION SHEETS

Choasing Options

1 Tap to see the Character options
sheet if it’s not already displayed

2 Tap to select an option.

4 Double lines indicate that you
can choose more than one option.
Tap each one you want. If you
change your mind, tap again to
clear your choice.

. Asingle line indicates that you

. can only choose one; tap to the

option to see the other choices;
tap to select one.

% Tap to display the Paragraph

options sheet.

£ Enter information in a text field by
L writing in it

T To change a text field entry, draw
a cross out X through the text
and write in new text

5 Tap the appropriate action button

4 To apply your choices and
continue using the sheet, tap
Apply

4 To close the sheet without
applying the choices, tap Close

To find out more about how to edit text in
fields, see Editing Labels, Titles, and Fields
in Editing and Formatting text (chapter 5).

GO CONFIDENTIAL FUNDAMENTALS
SEPTEMBER 26, 1990 9



MAKING A SELECTION

Making a Selection

Sometimes it’s obvious what you want your commands to apply to. For
example, to style a word in boldface, you draw a B over it. At other times, you
need to tell PenPoint what to act on by first selecting it. For example, to make
an entire sentence bold, you select it and then draw a B over the selection.
Selected text looks different: the background is dark and the letters are light.

etable. It's cheap
R %

e,

"to/;gréw and it survives well in
cof A

i
Boteraionofitseemb

USING THE GO COMPUTER
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To select a single character hold the
pen on the character until you see it

highlighted.

To select a word, sentence, or
paragraph use taps. For example, a
doubletap selects a word.

To select a series of letters, hold the
pen down until you see the charac-
ter beneath the pen highlighted and
then drag to the end of the selection.

Draw brackets [ ] to select the

enclosed text.

Draw a new bracket [ to adjust the
selection.

To select an entire document tap
the entry in the table of contents.

GO CONFIDENTIAL
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MAKING A SELECTION
MAKING A SELECTION

To find more about using gestures to select text read Selecting Text in chapter 5
(Editing and Formatting Text).

To clear text you've selected, tap in the
text somewhere outside the selection. To
clear a part of the Notebook you've
selected with a plus +, draw a plus + on it
again.

GO CONFIDENTIAL FUNDAMENTALS
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COPYING AND MOVING INFORMATION

Copying and Moving Information

You can use gestures to copy {{tap hold dragj} or move {{hold dragj} :

v a document to another location in the Notebook

v information to another place on the page

v information between pages.

smawoo” J

”l un‘m& 1

Documem Inserf Case = I

eggplantanc Ct. All hd other squash has become
oo |tlately. You'd spread this curry

as'you grill them. Pete in the

N1y HeBd u pov naiie Fo this
at product. lt. s eggplant puree

g hcandomerspxcesmambetousemsaucs, i

pas
we'd turned it down?
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Jor barbecmng vegetablw hke :

. fithaclever way to'make sure
A to stay on the vegetables yet

ips and 'So forth, Rcmembg:twhat a hltthat.:

To move a sentence from one place
on a page to another:

Tap three times to select the
sentence.

4 Lift your pen away from the
screen after each tap, but make
the three taps in fairly quick
succession.

4 You know the sentence is selected
when the background turns dark
and the letters light.

Select Move from the Edit menu.
The sentence is temporarily

replaced by an icon, which is
surrounded by an animated border.

Drag the icon to its destination and
lift the pen away from the screen.

(Where you lift the pen determines
where the text goes.)

PenPoint moves the sentence to the
new location.

GO CONFIDENTIAL
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COPYING AND MOVING INFORMATION
COPYING AND MOVING INFORMATION

When you copy or move more than a line of
text, PenPoint temporarily represents it as
an icon to make it easier to drag. If you
turn to a different page, the icon follows.

To move a document to a different location in the Notebook:

v Start from the table of contents. Put the pen down on the title and hold it
there until you see the animated border on the title which tells you it’s
ready to be moved.

v Drag the title (and the document along with it) it to another place on the
table of contents.

v Lift the pen away from the screen.

The animated border disappears, and the document is moved to its new

location. Note that the page number for the document has changed to reflect its
new location.

You can also select what you want to copy or move and then choose the
appropriate command from the Edit menu.

GO CONFIDENTIAL FUNDAMENTALS
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GETTING HELP

Getting Help

You can get two kinds of help from PenPoint: Quick Help and the Help
notebook. Use Quick Help when you see something on the screen you want to
know more about, and the Help notebook when you want to look up a topic.
You can continue working while displaying either kind of help.

Getting Quick Help

Quick Help briefly describes the part of the Notebook or page you asked about
and lists the gestures that work there.

¥ Draw a question mark ? over
whatever you want Quick Help
about.

You'll see a brief description of it,
along with a list of gestures you can
use in this area.

4 If you turn to a different page in
the Notebook, Help goes with
you.

2 Tap to close Help.

If the information doesn’t fit on the Quick
Help page, you can bring the hidden part
into view by pressing the top [?] arrow in
the scroll margin.

USING THE GO COMPUTER GO CONFIDENTIAL *
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GETTING HELP
GETTING HELP

Using the Help Notebook

The Help notebook organizes information topically so that you can find out
how to use different features of the GO Computer or the programs you’ve
installed on it.

1 Tap. the Help icon once to open it.

2 You'll see instructions on using the
Help notebook.

4 Tap on the appropriate page
number in the Help table of
contents to see a particular topic.

% Tap the close corner to close the
notebook.

To move the notebook to see what's below
it, drag the title line.

GO CONFIDENTIAL FUNDAMENTALS
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CHAPTER 2

Drawing Gestures

You use gestures to give commands to PenPoint and to edit text in a document
or text field. Most gestures have corresponding menu commands, but you'll
find that the gesture is usually faster.

You can learn about gestures from the gesture profiles in this chapter. The
profiles show you how to draw gestures, what part of the gesture actually
activates a command, where gestures work, and what their effect is in each place
you use them.

PenPoint interprets gestures in the same way it does your handwriting. As in
handwriting, neatness and consistency are most important. You'll get the best
results if you draw gestures with a light, firm touch, and straight lines free of
hooks or extensions.

PenPoint interprets a gesture as complete when you lift your pen away from the
screen. If a gesture has more than one stroke, keep the pen very close to the
screen as you lift it between strokes, until you've completed the gesture.

The profiles in this chapter contain other important information. For example,
the italics gesture requires a Roman-style capital /with three lines that may
differ from the way you practice your uppercase /in the Handwriting Training,
If you make a gesture and it doesn't work, refer to it in the gesture profiles.

Programs you install in your
Notebook may add their own
gestures. Refer to those manuals
for more information.

Using PenPoint GO Confidential
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PENPOINT GESTURES TABLE

e TAP

Selects or activates what you touch.

se DOUBLE TAP

Selects a word in text; floats a page.

see TRIPLE TAP

Selects a sentence.

seeoe QUADRUPLE TAP

Selects a paragraph.

@ PRESS

Makes a character box in a writing pad
active; sets an insertion point in text.

« @— TAP-PRESS-DRAG

Copies a selection or object.

©— PRESS-DRAG

Moves a selection or object; selects a
series of characters.

X CROSS-OUT

Deletes text, icons, and other objects.
When drawn in a document title line,
deletes the document

Opens a pad for editing a word or
selection in text, fields, document titles,
and labels on tabs and buttons

Displays options for the text or object that
you check.

Opens a small pad for inserting text;
opens the Create menu in the Table of
Contents to create a new document.

?  QUESTION MARK

Opens Quick Help for the menu item, icon,
or other object the gesture is drawn over.

[ ] BRACKETS

Selects text; extends or reduces text
selections.

HORIZONTAL
—L2— PIGTALL

Deletes words in text.

DELETE IN PADS

Deletes words in the proof sheet and
editing pad character boxes.

VERTICAL PIGTAIL
(Text)

Deletes individual characters in a
document or text field.

GO Confidential
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VERTICAL PIGTAIL
(Pads)

Deletes individual characters in the
writing and editing pad character boxes.

INSERT SPACE Adds a space.
(Text)
L ?;SdEsg{T SPACE Adds one or more spaces in the writing
a

and editing pads.

l T FLICK (UP/DOWN)

Scrolls the line you flick on to the top or
bottom of documents and tables of
contents.

o FLICK (LEFT/RIGHT)

Scrolls the column you flick to the left or
right in documents and tables of contents.
On a document’s title line, turns to the
next or the previous page.

Scrolls to the top, bottom, extreme left, or
extreme right of a document.

Selects or deselects GoTo buttons, icons,
embedded documents, and names in the

~Send list.

MTT % DOUBLE FLICK
+ PLUS
==  SCRATCH-OUT

Deletes characters in character boxes,
text, writing pads, and fields.

4 CIRCLE-LINE

Opens a blank editing pad in text.

A\ CARET-TAP

Creates a large writing pad.

/A\ CHEVRON

Creates an embedded document.

CZD DOUBLE CIRCLE

Creates a GoTo button.

? |, ARROW UPDOWN

Increases or decreases the size of selected
text.

r UP-RIGHT

Opens a single-character writing pad.

_| powN.LEFT

Adds a paragraph break.

GO Confidential
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DOWN-LEFT-FLICK

Adds a one-line break in text without
beginning a new paragraph.

DOWN-RIGHT-FLICK

Adds é tab' in a document.

RIGHT-UP

L r |

Formats text with initial capital letters.

1l RIGHT-UP-FLICK

Formats text as upper case.

] RIGHT-DOWN

Formats text as lower case.

N CHECK-TAP

Displays options for an embedded
document.

P PROOF

Opens a proof sheet with possible spell-
ings and translations for editing a word.

E EJECT FLOPPY

Ejects a floppy disk. Works on icons and
disk titles in the diskviewer.

F rmo

Opens a dialog sheet that lets you search
a document or selection for a specific
word.

Opens a dialog sheet that lets you check
the spelling of a document (gesture in

document title line) or selection (gesture
in selection). '

Makes text bold. Works on a word or
selection.

I ITALIC Makes text italics. Works on a word or
selection. :

M MENU Shows or hides the Menu line. Works in
the document title line.

N NORMAL Makes text plain. Works on a word or

selection.

Shows or hides tabs. Works in the Table
of Contents on document titles, section
titles, and in documents on the title line.

GO Confidential
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U UNDERLINE Underlines text. Works on a word or
» selection.

C CORKMARGIN Shows or hides the cork margin. Works
in the document title line.

GO Confidential Using Penpoint Drawing Gestures-5



What it does: Selects or activates what you touch
with the pen.

Draw: Touch the screen firmly, then quickly
lift the pen. Wait a moment for the Lombard to
carry out your instruction.

What doesn’t work: Pressing too hard, tapping
repeatedly, "coloring in" the tap; hovering too
close to the screen after tapping.

Where else it works:

Chooses [Menu and Options: </|leét
Comm®nds censer
right

Carries out

instructions éﬁ)_lyl

Turns to Page Turns Pages <]23p>

(Table of Contents)

---------- @24 %> (Closes |
Floaters &

Opens icon

on bookshelf _] Tums to page |5

with tab on it
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What it does: Selects a word in text; floats a
page; expands or collapses section contents in
Table of Contents.

Draw: Touch the screen firmly twice, barely
lifting the pen between taps. Then lift the pen
away from the screen.

Double tap on a word to sedect
select the word

Double tap on a Table of
Contents page numberto ----- 824 >
open the page floating

Double tap on a tab to float
the tabbed page K

What doesn’t work: Lifting the pen tip too far
between taps; tapping on two different objects or
words.

Where else it works: A double tap on a GoTo
button floats the page attached to the goto
button.
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: : iiz. oo .';:‘::.TRIPLE-T AP . i

What it does: Selects a sentence.

Draw: Touch the screen firmly three times,
barely lifting the pen between taps. Then lift
the pen away from the screen.

What doesn't work: Lifting the pen tip too far
between taps.

Gestures-8



QUADRUPLE TAP

What it does: Selects a paragraph in text.

Draw: Touch the screen firmly four times,

barely lifting the pen between taps. Then lift
the pen away from the screen.

What doesn’t work: Lifting the pen tip too far
between taps.

Gestures-9



What it does: Selects a single text character; sets
the space immediately before the selected char-
acter as an insertion point; makes one character
box in a writing pad active (it is underlined).

Draw: Touch the screen on the character or
character box that you want to select until it is
highlighted (about one second) and then lift
your pen away from the screen.

giticiniLi1iciniT
in character e :
boxes piticiniviticiniT
in text HIGHEIGHT
creates an

insertion HIGHILIGHT
point

What doesn’t work: Tapping (lifting the pen
away from the screen too quickly).
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o : TAPPRESSDRAG :

What it does: Selects and copies a word or

object, and moves the copy to the desired
location.

Draw: Tap the screen and barely lift the pen
(this selects the word or object), then touch
the screen again and keep the pen tip in
contact. You'll see a moving double-dashed
line around the selection when it's ready to be
copied. Then, still without lifting the pen,
drag the selection to the desired location. Lift
the pen where you want to place the copy.

When the :
dashed line around it, you can drag
the copy to its destination.

What doesn’t work: Tapping repeatedly;
"coloring in" the tap; lifting the pen too far after
tapping; not waiting for the moving,
double-dashed line to enclose the selection or
object; lifting the pen before you finish dragging
the selection or object.

Where else it works: Copies a selection in text,
copies documents in the table of contents, and
copies bookshelf icons.

Gestures-11



What it does: Moves a text selection or a
selected object; selects a series of text characters.

To move an object or selection: Touch the

object or selection with the pen tip and wait until
you see a double-dashed line around the object or
selection; then, without lifting the pen, drag the
object or selection to the intended location. An
object will be moved to the precise point on the
screen where you lift the pen; selected text will
be moved to the whole space nearest the point
where you lift the pen.

To select text: Touch the pen to the screen and
wait for the first character to be highlighted;
then, without lifting the pen, drag the pen
through the characters to the last text character
you want to include in the selection.

What doesn’t work: Lifting the pen before the
double-dashed line forms around the selection,
or before you finish dragging the selection or
object.

Where else it works: Moves documents in the
Table of Contents and diskviewer; moves
bookshelf icons; dragging from the document
title line, moves open floating documents.
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What it does: Deletes the object or selection
directly beneath the X.

Draw: Make an X, using two distinct
strokes, over the selection or object that you
want to delete.

What doesn’t work: Drawing the gesture in one
stroke (connecting the two lines); making a
instead of an X; drawing strokes that are not
clean lines.

> X

connected lines hooked line

Where else it works: Deletes contents of a field,
documents from the table of contents, and icons
from the bookshelf; when drawn in a document's
title line, deletes the document.
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What it does: Opens an editing pad in text, text
fields, and labels for a character, word, or short
series of words.

Draw: Start anywhere in the area (character,
word, series of words) that you want to edit and
complete a neatly closed circle; ovals also work.
ovaswork. (D) 3 O VDL
(Opens a pad to edit just the u in "ovul.")

QY ITp
(Opens a pad to edit the whole word "ovul.")

What doesn’t work: Not starting the circle from
the top.

Overlapping parts of the circle too
much (overlapping a little is okay)

Not closing the circle C y

Where else it works: Opens an editing pad for a
document name in the Table of Contents, a
document title, or a label on a tab, icon, or GoTo
button.
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What it does Dlsplays options for a word in
text, or the selection or object over which you
draw the check.

Draw: Draw the check in one gesture, with the
beginning of the first downward stroke on the
object whose options you want to see.

VoY

Down Or mirror

What doesn’t work: Drawing the check at a hori-
zontal or vertical angle; unclean lines (hooked).

LN

vertical (simi-  horizontal hooked
lar to add space (similar to new
gesture) line gesture)

Where else it works: Displays options for text,
icons, documents (when drawn in the document
title line), tables of contents (when drawn in the
table of contents title line), and accessories
(when drawn in the title line of the accessory).
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What it does: Opens a small pad for inserting
text; opens the Create menu in the Table of
Contents to create new documents.

Draw: Starting the gesture at the lower left,
make an upside-down V, and a writing pad
pops up above the tip of the gesture; the tip
of the gesture sets the insertion point for the
new text.

POPS % PAD

What doesn't work: Making two strokes;
creating a loop at the tip; starting on the right
side of the caret; or cluttering the gesture with
extra hooks or wiggles.

2 NVAVRVAN

These caret gestures won't work.
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7 QUESTIONMARK

What it does: Opens Quick Help.

Draw: Draw a question mark over any screen
element to see Quick Help for that element. For
best results, draw the question mark so that the
loop joins the stem over the center of the target.
Don't forget the dot (and don't lift the pen tip too
far before making it).

What doesn’t work: Drawing the question mark
off the center of the object you want help in
understanding; failing to dot the question mark;
making an elongated question mark.

7= Id

elongated stem

off-center

o
Where else it works: Labels (the left column) on
option sheets.
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[ ] BRACKETS

What it does: Brackets is really two gestures,
which select the words enclosed by the brackets.
Once a selection is made, you can move either or

both brackets to increase or decrease the selection.

If you draw through a character with the left
bracket, that character will be inside the selection;
if you draw through a character with the right
bracket, it will be outside the selection. If you
place an insertion point into text, a bracket will
extend its selection to the insertion point without
need of the second bracket.

Draw: In one stroke, starting at the top, draw
three sides of a rectangle (you can draw either
bracket first; a beginning bracket opens to the
right; a closing bracket opens to the left).

Selects[words oacharacters.
Selects words or cEarac ers.
What doesn't work: Drawing from the bottom

up; extremely curved or pointed lines; curled or
cupped bracket legs.

L <

Where else it works: You can use a single
bracket to adjust a selection's contents even if you
created the selection in some other way.
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HORIZONTAL
—2— . PIGTAIL

What it does: Deletes words in text and translated
text from character boxes in pads. Deletion
begins at the start of the horizontal line and ends
at the loop. The "tail" following the loop doesn't
delete anything. _

Draw: From left to right, make a horizontal line
with an upward loop.

this delete -e-ﬁe-e-ﬁ-m-eramrds

results in this delete words
What doesn’t work:
delete orreerrrefeauuosds
downward loop

deleteWe words

slanting the line

delete ore®m—saese wWords
drawn right to left
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DELETE INPADS

What it does: Deletes translated text from
character boxes.

Draw: A horizontal line through the letters
you want to delete. :

wleletelo|r|d]. ©

What doesn't work: Drawing the line from right

to left.
A ol

slanting the line too much
(some slanting is okay)
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. VERTICAL PIGTAIL
 (Text)

What it does: Deletes individual characters in
a document or text field.

Draw: A vertical line with a loop at the end.

For the best results: Begin the gesture within

the boundaries of the character you want to

delete (the place first touched by the pen tip

determines what is deleted); draw it straight

through, create the loop above the character,

and end with a su'aig? line.
g

delete a singqle character.

What doesn’t work: j
twl) tw 06

tVVOis?

ends with a begins above  starts with
circle the character  a loop
th twfo twof

slanted, drawn begins below

ends with
through several the character ;. rved
letters line
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- VERTICAL PIGTAIL
- (Pads) -

What it does: Deletes individual characters in
the writing and editing pad character boxes.

Draw: Begin the vertical line within the
character box and extend it through the top of
the box, ending with a loop. The loop is the
key to differentiating this gesture from a flick,
so don't worry about the length of the "tail"
you leave after the loop 7/

[blelh] slt]e@]

What doesn't work:

blelXZl sl t|=»|blelilsl]ct

gesture ends inside translated as a letter
the character box

9
blel’aslt blelAls|t

slants too much gesture starts
below box
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~ INSERT SPACE

What it does: Inserts one space.

Draw: With one down-right stroke, make a
capital letter L between the letters you want to
separate. (If you touch a character, it will be on
the right side of the space that is opened.)

insert agpace between letters

For the best results: Start the gesture in the
middle of the line, because the place where the
pen first touches sets the insertion point. To
insert more than one space repeat the gesture.

To insertyepeat the gesture
To insert: grepeat the gesture
To insert: qrepeat the gesture

What doesn't work: Touching the character to
the left of where you want to insert the space.

gesture begins too high  insert dspace

notarightangle insert @ace
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INSERT SPACE
- (Pads).

What it does: Adds one or more spaces in the writing
and editing pads.

Draw: With one down-right stroke, make a capital letter L.
Begin it in the middle of the character box that you want to
insert the space before, and end the gesture below the box.

belTw_e
| S

Make the bottom line the length of one character box if
you want to insert one space, two to insert two spaces,

and so forth.
ble|l 1|7 |— @ =>|b|le| 1 |—|w]|®
—
beT——-—s*be__[wJ@
| —
What doesn't work:
ble |l |w|— © blel| 1w l_..l ®
:)hoe entire gesture is within the the vertical lég is drawn on
X the character box line
blell lwl e

the gesture is drawn at an odd angle

Gestures-24



|T FLick wemown)

What it does: Scrolls text in documents (scroll
margins, or anywhere on a page) and Table of
Contents.

Draw: Make a straight vertical line (any length);
start the flick where you want the scroll to begin.

vertical
flicks l T

What doesn’t work: Gestures that are at odd

angles; hooks at beginning or end of flicks;

g)uching the screen too slowly before starting to
ick .

odd angles

don't work j f \ \
Where else it works: Scrolls the choices in
an option sheet. In a document header,

zooms and reduces the page view. Exposes
and hides tab labels.

Ie) [«
Flick on hidden tabs to | -
see/hide labels - ]
Flick up here to —)-E' — <
reveal hidden tab ) s

— -

-, -,
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o— " FLICK (LEFT/RIGHT)

What it does: Scrolls documents and the Table
of Contents left or right. On the document title
line, turns to the next or previous page.

Draw: Make a straight horizontal line (any
length).

previous page o0— next page -—o
scroll left o— scroll right —o

What doesn't work: Gestures that are at odd
angles; hooks at beginning or end of flicks;
touching the screen too slowly before starting to
flick.

odd angles &~ o

don't work ~

Where else it works: In a notebook with
many tabs, flick-left displays tabs in discreet
columns so that all are visible; any gesture
puts them back into one column.
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ll TT 3 &= DOUBLEFLICK

What it does: Scrolls to the top, bottom, left, or
right edge of a document.

Draw: Start the flick where you want the scroll
to begin and make a straight line of any length;
barely lift the pen tip and then make a second
flick.

What doesn’t work: Flicks that are at odd angles
or made in different directions; lifting the pen too
far before making the second flick; hooks at the
beginning or end of flicks; touching the screen too
slowly before starting to flick.

Where else it works: You can flick anywhere in
a document, in the scroll margin, and in tables of
contents; on a document title line, scrolls to the
Table of Contents.
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+ - PLUS:

What it does: Selects or deselects GoTo buttons,
icons on the bookshelf, embedded documents,
names on the Send list.

Draw: Make two strokes at right angles,
keeping the pen tip close to the screen between
strokes. Start with the downward line; draw the
horizontal line from either direction. The
gesture's lines should intersect directly over the
selection, icon, or button you want to select or

deselect. I

What doesn’t work: Making an "x" instead of a
"+"; not lifting the pen enough to separate the
two parts of the gesture; lifting the pen tip too
far between drawing the two lines; hooks at the

beginning or end of lines.
too X-like joined hooked
lines
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What it does: Deletes characters and words in
text, and in writing pads and fields.

Draw: Three horizontal lines back and forth
on top of each other without lifting the pen

(a very compressed Z).

—— —TE

P-Pejsmgeiisi- A W ORD

What doesn't work:

<

loose
zigzags

disconnected
lines

—

continuous
loop

hooked at
the end
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- CIRCLE-LINE

What it does: Opens a blank editing pad for a
word in text, or for selected text, to allow you to
replace the word or words.

Draw: Over the word or within the selection that
you want to replace, draw a circle or oval, then
make a horizontal line across the middle of it.
Lift the pen tip no more than the barest distance
from the screen before drawing the line, which
you may begin from either the right or left.

On a A plain circle gi€Rre opens a
single pad filled with text. A circle-

word line gisture opens a blank pad.
Ona  A'plain circle—gisture opens a
selec- pad .fil 0 ircle-
tion |ine-glsture opens a blank: pad.

What doesn’t work: Lifting the pen too far
before drawing the line; too much angle on the
horizontal line; too much overlapping or failing
to close the circle or oval.

Too much angle &
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What it does: Creates a large writing pad.

Draw: Starting the gesture at the lower left,
make an upside-down V, and then, barely
raising the pen, tap over the caret point.

[ ]

A

What doesn’t work: Tapping too far off-center;
making the tap too far inside the caret; lifting
the pen tip too far before tapping.

°
too far tap inside
off-center
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/A CHEVRON

What it does: Creates an embedded document.

Draw: Two carets, one nested beneath the
other (either upper or lower can be made first).
Each caret gesture should be drawn from left to
right with one stroke; just barely lift the pen
before making the second caret.

9//'§\Center point of the gesture

What doesn't work: Using more than two
strokes to make the gesture; making either caret
from right to left; making sloppy carets with
extra hooks or wiggles; lifting the pen tip too
far before making the second caret.

A
A\ A

Too much Too much space
overlapping between the carets.
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(D DOUBLE CIRCLE

What it does: Creates a GoTo button.

Draw: Start where you want the GoTo button
to appear and make two distinct circles (or
ovals). The link button will appear under the
center point of the gesture. The circles do not
have to intersect, but you can position a button
more precisely if they do. Be sure to keep the
pen close to the screen until you've completed
both circles.

— Center point of gesture

What doesn't work: Lifting the pen tip too far
from the screen; sloppy circles that overlap
themselves or look like other shapes.

&

Figure-eights don't work

Where else it works: You can create GoTo
buttons almost anywhere; eg., in stationery
documents, the cork margin, tables of contents,
text documents and numeric tables, and note-
books on the bookshelf.
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What it does: Increases or decreases the point
size of a word or text selection. ,,

draw tip left-to-right Jr

Draw: Use two strokes to draw an arrow; you
can draw the shaft from the bottom up or the
top down, and you can draw either the arrow
tip or the shaft first, but be sure to make the
arrow tip in one stroke from left to right. Just
barely lift the pen tip before drawing the tip.

i
incre

t auailable size
decreases to next available size

decreases to n

What doesn’t work: Arrows made with one
stroke; lifting the pen tip too far between parts
of the gesture; too much angle on the arrow
shaft; making a loop at the arrow tip; starting
the arrow tip from the right; cluttering the
gesture with extra hooks or wiggles.
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r‘” UP-RIGHT

What it does: Opens a single-character writing
pad.

Draw: With one up-right stroke, beginning the
gesture from the bottom (on the text line or in the
middle of the line), make an upside-down capital
letter L just before the place where you want to
insert the character. The place where the pen tip
first touches determines the insertion point

insert a cheoracter
insert a chracter

insert a chracter

insert a character

What doesn’t work: Not 90° (the gesture must be
made at a right angle to the text line); starting the
gesture too far below the text line.
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| powN-LEFT

What it does: Inserts a paragraph break to the
immediate right of where you make the gesture.

Draw: With one down-left stroke, starting at the
top (within the line of text or just above it),
make a backwards capital letter L (to a point
just below the line of text) where you want to
insert a paragraph break.

Use it to insert a break.fTo start a
new paragraph...

Use it to insert a break.
To start a new paragraph...

What doesn’t work: Not drawing the gesture at
a right angle to the text line; making it too much
like a check; starting the gesture at the bottom,
or too far above the line.

Use it to insert a break )To start a
new paragraph...
not a right angle
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| DOWN-LEFT-FLICK

What it does: Inserts a one-line break into text
without beginning a new paragraph.

Draw: With one stroke, make a backwards
capital letter L where you want to insert a line
break, then, barely lifting the pen, make a
right-to-left flick just below the horizontal line.
The flick should be parallel to and about the
same length as the horizontal line.

|

-0

What doesn’t work: Taking more than two
strokes to make the gesture; making the gesture
at odd angles; lifting the pen too far above the
screen before making the flick; making the
flick in the wrong direction.
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|__ DOWN-RIGHT-FLICK.

What it does: Inserts a tab into any document .

Draw: With one stroke, make a capital letter L
where you want to insert a tab, then, barely
lifting the pen, make a left-to-right flick just
below the horizontal line. The flick should be
parallel to and about the same length as the

horizontal line.

[, cm—

What doesn’t work: Taking more than two
strokes to make the gesture; making the gesture
at odd angles; lifting the pen point too far from
the screen before making the flick; making the
flick in the wrong direction.
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| RIGHT-UP

What it does: Formats text with initial caps.

Draw: With one stroke, horizontal then upward,
make a capital letter L that's lying on its back.
The horizontal line should begin on a targeted
character and cross through the word(s) to be
formatted and the upward line should be a 90°
angle, immediately after the last character you
want to format. When formatting a large
selection, make the gesture anywhere within the

selection.
o— |

From All Caps To Initial Caps

What doesn't work: Making the gesture in two
strokes; making the gesture at odd angles;
underlining the words with the horizontal line
instead of drawing it through the words.
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What it does: Formats text and selected text as
upper case characters.

Draw: With one stroke, horizontal then upward,
make a capital letter L that's lying on its back.
Then, barely raising the pen, make an upward
flick beside it. The horizontal line should cross
through the word(s) to be formatted and the
upward line should be a 90° angle, immediately
after the last character you want to format. When
formatting a large selection, make the gesture
anywhere within the selection.

o—
converts to cu-ppe-p—eeee-u

converts to UPPER CASE

What doesn’t work: Taking more than two
strokes to make the gesture; making the gesture
at odd angles; lifting the pen too much before
flicking; underlining the words with the
horizontal line instead of drawing it through
the words; making the flick downward instead
of upward, or at an odd angle.
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~ ] RIGHT-DOWN

What it does: Formats text as lower case.

Draw: With one stroke, horizontally then
downward, make a capital letter L that's face
down. The horizontal line should cross through
the word(s) to be formatted and the upward line
should be a 90° angle, immediately after the last
character you want to format.

1
CONVERTS TOLEWER-€ASE

CONVERTS TO lower case

What doesn’t work: Making the gesture in two
strokes; making the gesture at odd angles;
underlining the words with the horizontal line
instead of drawing it through the words.
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What it does: When an embedded document's
title line is hidden (where you would normally
use a plain check gesture to display document
options), this gesture displays options for the
document. -

Draw: Draw the check in one gesture. Then,
barely lifting the pen, make a tap just to the

right of the check. \/

What doesn’t work: Drawing the checkmark at
a horizontal or vertical angle; unclean (hooked)
lines; tapping in the middle or beneath the
check mark; lifting the pen too far before
tapping.

checkmark can't tap can't be inside

be vertical check mark

Where else it works: Within embedded docu-
ments, works anywhere.
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What it does: Opens a proof sheet that
includes alterative spelling choices for editing
a word.

Draw: Anywhere within the word or selection
that you want to proof, draw a capital letter P.

Proof tRRis word only

What doesn’t work: Making the P so that most
of the gesture is above or below the line, or
drawn over a portion of a word other than the
one that you want to proof.

Proof thLFS word only

Proof thﬁ word only
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E EJECT FLOPPY

What it does: When you are using the
diskviewer, this gesture ejects a floppy disk.

Draw: In diskviewer, make a capital E, just
as you would write one in text. The gesture
works on the disk icon and the disk label.
This manner of ejection "remembers” the disk
and retains an image of its icon.

Disks
Diskl 7
Volume Edit View Sort Show
Name Ivpe
Penpoint Dir

The gesture works in these two
places in the diskviewer

What doesn’t work: Trying to use this gesture
anywhere except in the diskviewer; making the
E differently from the way you practiced it in
the Handwriting Training.
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F: FIND

What it does: Opens a dialog sheet that lets
you search a document or selection for a
specified word.

Draw: Using three strokes (even if you didn't
practice Fs that way in the Handwriting
Training), make an upper case F wherever you
want the Find & Replace option sheet to
appear; keep the pen tip close to the screen
while making the gesture.

What doesn’t work: Not using three strokes to
make the gesture; lifting the pen too far before
completing the gesture.
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S seElL

What it does: Opens a dialog sheet that lets you
check the spelling of a document (when the
gesture is drawn on the title line) or selection
(when the gesture is drawn anywhere within the
selection). Permits the addition of unrecognized
words to the dictionary

Draw: To check the spelling of a selected word
or sentence(s), make an uppercase S over the
selection. To begin a spell check of a whole
document, make the S on its title line; to begin a
running spell check from within a document,
make the S on the first character of the first word
you want checked.

Checks one selected
ing

What doesn't work: Making the S so that most
of the gesture is above or below the character
line or drawn over a portion of a word other than
the one you want to check, or drawn
substantially outside the selection.

too much outside the selection
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B BQLD :

What it does: Make text bold. In the title line
of a document, the B gesture hides or shows
the border that encloses the document.

Draw: Make an uppercase B over the word,
sentence, or selected text that you want to
appear as bold text.

Bold one w§Bd.
Bold one word.

Bold an entire selection.

What doesn't work: Making the B so that
most of the gesture is above or below the line,
or drawn over a portion of a word other than
the word that you want to format, or drawn too
much outside the selection; making the B in a
different way than you did in the handwriting
training.
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What it does: Makes text italics.

Draw: With three strokes make an uppercase
I (no matter how you practiced this letter in
the Handwriting Training) over the word,
sentence, or selected text that you want to
appear in italics.

Italicize one wdrd.

Italicize one word.

Italicize an entire selection.

What doesn’t work: Making the I so that most
of the gesture is below the line, or drawn over
a portion of a word other than the one that you
want to italicize, or drawn too far outside the
selection; failing to use three strokes to make
the I gesture (a one-stroke I will be interpreted
as a flick).
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| M MENU

What it does: If you want more room on the
screen for documents, you can hide the menu
line by making the M gesture in the document
title line; when you need them again, the M
gesture in the title line re-displays the menus.

Draw: Make an uppercase M in the title
line of the document.

What doesn't work: Making the M too
different from the way you practiced it in the
Handwriting Training.
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N NormaL

What it does: Formats text as normal (plain),
removing such styles as bold, italic, or
underline.

Draw: Make an uppercase N over the word,
sentence, or selected text that you want to
have appear in the normal format.

Changes formatted text to normal

Changes formatted text to normal

What doesn’t work: Making the N so that
most of the gesture is above or below the line,
or drawn over a portion of a word other than
the one that you want to format, or drawn too
much outside the selection that you want to
format; making the N in a different way than
you did in the handwriting training.
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What it does: Determines whether or not a tab
shows along the edge of a notebook. When a
tab is showing, the T gesture hides the tab;
when a tab is hidden, the T gesture displays it.

Draw: In two strokes make an uppercase T in
either the document title line or the Table of
Contents title line.

What doesn't work: Crossing the T so that it
looks like an X.
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U UNDERLINE

What it does: Underlines text.

Draw: Make an uppercase U over the word,
sentence, or selected text that you want to
appear underlined.

Underline one M.

Underline one word,

nderlin ntir ] ion

What doesn't work: Making the U so that
most of the gesture is above or below the line,
or drawn over a portion of a word other than
the one that you want to underline, or drawn
too much outside the selection; making the U
too much likea V.
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. cork MARGIN

What it does: Shows/hides the cork margin.

Draw: Make an uppercase C in the title
line of the document.

What doesn’t work: Starting with a loop at
the top of the C, closing it so much that it's
interpreted as a circle, or otherwise distorting
it.
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CHAPTER 3

Using the Installer

You use the Installer to add a variety of things to your Notebook, including
those things — like your handwriting profile and your personal dictionary —
which make it uniquely your Notebook. Use the Installer when you want to
add or deactivate (temporarily remove):

4

4

4

v

4

applications
fonts

device drivers (instructions for devices such as printers, plotters, and
modems)

services such as network, electronic mail, and information services
preferences
handwriting profiles

dictionaries.

When you install something, PenPoint remembers which disk (volume) you
used to install the information and its location on the disk. This location is
called its home volume. PenPoint refers to the home volume when you save or
update something, or when you deactivate and then reactivate it.

GO Confidential

Some software is automatically
installed when you insert the floppy
disk in the disk drive. In that case,
you'll see an installation message. If
not, then install it with the
Installer.

Using the GO Computer

Installing Applications and Devices Odlober 3, 1990 1



USING THE INSTALLER

Finding Out What's Installed in the Notebook

When you first open the Installer, it shows you what's currently installed in the
Notebook. You'll see a sheet for each category such as Applications and Fonts.
PenPoint lists whatever you have in the Notebook that matches that category.
For example, on the Fonts Installer sheet, you'll see a list of the fonts you've
installed in your Notebook.

Connect the PenPoint computer to

a disk drive
Tap the Installer icon to open it

Tap the arrow in the title line to see
a list of the other Installer sheets
and tap to select the Fonts sheet if
it's not displayed

Name shows which profiles are
installed currently in the Notebook

Modified tells you if you've
changed it since the last time you
saved it

Size tells you how big it is so you
can determine whether you have
enough memory

Current shows which one is in use.
Tap to select another set.

Tap the close corner to close the
Installer

(screen) TOC with Installer tapped; (object) Installer turned to Fonts sheet
figure 3-1

Using the GO Computer GO Confidential
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Installing an Application or Utility from Disk

To install something, open the Installer, turn to the sheet for the category of
items you want to install, and choose Install from Disk. PenPoint opens a
diskviewer for the connected disk and lists the items it finds on the disk for that
category. Select one to install.

1 Connect the PenPoint computer to

a disk drive

2 Tap the icon to open the Installer

3 Tap the arrow in the title line to see
the list of install sheets, and tap to
choose the one you want to see

4 Tap Install from Disk

5 Tap the disk icon to see its contents

6 Tap to select the item to install

7 Tap the appropriate action button
(object) application install sheet with tap on Install from Disk;
(object) Installer with disks icon already open and a tap on Draw application
figure 3-2
If you don't have enough room in the Notebook to add something, PenPoint
displays a message to this effect. See “Managing Memory” in Chapter X,
“Troubleshooting and Tips” for details.

Automatic Installation
Some disks install their software automatically. You'll see a list of the disk
contents, and one item may be preselected. To install it, tap the Install button.
Or tap to choose another item and install that one.
If you don't see an installation message when you insert the disk, use the
Installer to add the items to the Notebook.
GO Confidenfiol Using the GO Computer

Installing Applicotians and Devices October 3, 1990 3



Creating a New Personal Profile

The first time you use Handwriting Training, you rename the basic (generic)
handwriting profile so you can save it as your own. Similarly, you can create sets
of preferences and dictionaries by copying the generic one or an existing one
and then adding to it. For example, you might install a district sales office
dictionary, create a new one based on it, and then modify it to include specific
customer and contact names for your sales region.

When you choose preferences and
add words to the dictionary in the
Notebook, you are changing the
generic sets. If you later want to
create a new set based on the
generic one, you may need to reset
the preferences and delete
unwanted words from the

dictionary.
To copy a dictionary:
1 Connect the PenPoint computer to
a disk drive
2 Tap the icon to open the Installer
3 Tap the arrow in the title line to see
the list of install sheets, and tap
Dictionary
4 Tap Create
Write in a name
6 Tap the name of the dictionary on
which you want to base the new one
Using the GO Computer GO Confidential
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7 Tap to choose a Home Volume

The volume that's currently selected
is the home for the dictionary you
chose in Start From, so if you want
this dictionary to have the same
home, you don't have to change

anything.

To choose a different home for the
new dictionary, insert a disk or tap
its volume name.

8 Tap the appropriate button

(object) Dictionary install sheet with Create tapped;

(object) Create sheet with "Sales Rep Dict" written in the name field and the home
changed from the hard disk.to Floppy 2

figure 3-3

You can leave the name field blank,
and PenPoint will use the name of
the dictionary in the Start From
field and add the number 1 to it, s0
Dictionary becomes Dictionary 1.

GO Confidential Using the GO Computer
Installing Applicatians and Devices Odober 3, 1990 5



Saving Your Changes

The Installer keeps track of any modifications to things you've installed. To
save these changes copy them to the home volume. If you don't want to keep
the changes, restore an earlier version by updating it from home.

Connect the PenPoint computer to

a disk drive
Tap the icon to open the Installer

Tap the arrow in the title line o see
the list of install sheets, and tap to
choose the one you want to see

Check to see whether you've
modified your choice since the last
time you saved it to disk. If so you
can save the changes or restore an
older version.

Tap to select it

To save new changes choose Copy
to Home from the Home menu

To restore an earlier version choose

Update from Home

(object) service install sheet with Dot Matrix printer showing it's been modified and

Copy to Home tapped on Home menu

figure 3-4

As a shortcut, draw a {{H}) on the
name of an item in the Installer to
copy it to home, and a {{U}} to
update it from home.

You can rename an item in the usual way, by drawing a circle on it and
changing it in the editing pad. PenPoint considers renaming something a

modification of it.

Using the GO Computer

6

GO Confidential
Rev. 0.1




Deactivating Applications and Utilities

You can use the memory in your computer most efficiently by deactivating the
applications, handwriting profiles, and services you're not using. Deactivating
them is a way of temporarily removing them. For example, you might
deactivate the applications and services you won't be using on a trip.

‘When you deactivate something PenPoint deletes it from the Notebook, but
leaves a placeholder and remembers its home volume. You can reactivate
something in one step instead of having to reinstall it completely.

1 Connect the PenPoint computer to

a disk drive
2 Tap the icon to open the Installer

3 Tap the arrow in the title line to see
the list of install sheets, and tap to
choose the one you want to see

4 Tap o select what you want to
deactivate

5 Choose Deactivate from the Home
menu to remove it but leave a

placeholder for it

(Make sure you've copied the most
recent version to home before you
deactivate anything.)

Choose Reactivate to reinstall
something.

(object) application install sheet with Draw tapped and Deactivate selected from
Home menu
figure 3-5

As a shortcut, draw a {{D}} on the
name of the item in the Installer to
deactivate it, and a {{U}} to
reactivate it.

Draw a cross out {{cross out}} to
delete an item. (If you delete it,
you'll need to reinstall it when
you're ready to use it again.)

GO Confidentiol Using the GO Computer
lnstalling Applications and Devices Odlober 3, 1990 7



When you deactivate or delete an application, PenPoint tells you how many
documents are currently using the application. If those include the one you're
working on you can quickly save any changes by turning to another page in the

Notebook before you deactivate the application. To save the changes to floating
documents, close them.

Using the GO Computer GO Confidential
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Changing the Home Volume

At times you may find it convenient to set a different home volume. For
example, you might decide to consolidate dictionaries from different floppy

disks to a single disk.

In Alpha avoid changing the home of an application or service, since PenPoint refers to data
on the original home voiume when it reactivates or reinstalls the application or service.

1 Connect the PenPoint computer to

a disk drive
2 Tap the icon to open the Installer

Tap the arrow in the title line to see
the list of install sheets, and tap to
choose the one you want to see

4  Draw a check {{checkmark}} on the
name of the item whose home you
want to change

6 Tap to select a new home volume

(object) dictionary install sheet with check on Sales Rep Dictionary (floppy 2);
(object) option sheet with tap on hard disk
Figure 3-6

The Home Path is the directory in which PenPoint expects to find the
installable file. When you change the home, PenPoint creates a directory for it
on the new disk. There's no need to change the path unless, for example, the
path conflicts with one you've set for a specific network configuration.

You can also get to the options sheet on which you change the home volume by
tapping a name to select it and choosing Options from the Edit menu.

To change an item’s home volume
and copy it there in one step, open
a diskviewer and move the item
from the install sheet to a location
on the diskviewer.

GO Confidential Using the GO Computer
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Installing Devices and Services

Before using a printer, modem, or other serial device or service, you install its
driver with the Installer and then set options for it in the Device notebook.

Before using a device or service make sure you have connected the physical

equipment properly. See “Setup and Care” (chapter XX). Also, consult the
manual that comes with your equipment for specific settings your should use.

Connecting a Printer

When you're ready to attach a printer to the PenPoint computer, you install the
printer driver and then set options for it — such as the model of the printer
and the port it will use — in the Device notebook.

You only need to set up this information once. When you're ready to print, use

the Printer Service option sheet to tell PenPoint you've attached the printer and
then choose Print.

1 Install the printer driver with the
Instailer

Tap to open the Device notebook

w

Tap the page number to turn to the
Printer page

Choose Add from the Edit menu
Write in a name for the printer

Tap 1o select the type of printer

N o O o~

Tap to select a port

information on seiecting the Basestation or Printer port will be included in Beta jm September
30, 1990

If you're connected to a PC or
network, tap to select the printer
name

8 Tap Ok to accept these settings

(screen) TOC Device notebook tapped on bookshelf (object) Device notebook open ‘

Using the GO Computer GO Confidential
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and tap on Printer page number,

(object) Printer page with Add selected from Edit menu and Add sheet displayed;
write in name for printer "Sales Area Laserjet”

figure 3-7

After adding the printer, PenPoint displays another set of options so you can
choose the appropriate model.

1 Tap to select the name of the model
of the printer you're connected to

2 Tap Ok to add the printer to the
list of available printers

(object) option sheet that comes up after you tap Add with HP Laserjet selected
figure 3-8

Setting Printer Options

PenPoint lists the printer's name and type on the Printer device sheet. The
setup requirements for each printer may vary, so to complete the setup
information, choose the appropriate printer options. For example, on the:

v Service sheet, add the printer name to the list of equipment sharing the
same port

v Serial sheet, set options for how the data will be sent, such as the flow
control or baud rate (Consult the manual that comes with your equipment
for these specifications.)

v Options sheet set options for the printer's capabilities, such as paper
handling,

1 On the Printer sheet, draw a check
{{checkmark}} on the name of the
printer to display the printer option
sheets

(Or, tap to select the name of the
printer and choose Options from
the Edit menu)

2 Tap the arrow in the title line to
display a list of option sheets and
tap Service to see it

3 Tap the name of the printer you've
just created

GO Confidential Using the GO Computer
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4 Tap On if you're currently
connected to the printer or Off if
you're not :

5 Tap the appropriate button

(object) Printer sheet in Device notebook with check on HP Laserjet;
(object) Printer options sheet with Service sheet displayed
figure 3-9

To set the serial options:

1 On the Printer sheet, draw a check
{{checkmark}} on the name of the
printer to see the option sheets

2 Tap the arrow in the title line to
display a list of option sheets and
tap Serial to see it

PenPoint lists the serial port you've
previously selected on the Add
Printer sheet

W

Tap 1o see the different choices in
each category, tap to choose the
appropriate ones

(Consult the manual that comes
with the equipment for the

appropriate setting)

4  Tap the appropriate button

(object) Printer sheet in Device notebook with check on HP Laserjet;
(object) Printer options sheet with Serial sheet displayed

figure 3-10

To set specific printer options:

1 On the Printer sheet, draw a check
{{checkmark}} on the name of the
printer to see the option sheets

Using the GO Computer GO Confidential
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2 Tap the arrow in the title line to
display a list of option sheets and
tap Options to see it

PenPoint lists the printer model and
the port to which you'll attach it

3 Tap to see the different options, tap
to select them

4 Tap the appropriate button

(object) Printer sheet in Device notebook with check on HP Laserjet;
(object) Printer options sheet with Options sheet displayed

figure 3-10

Printing a Document

Once you specify the settings for the printer in the Device notebook, you can
save this setup information on the home volume, so you don't have to reset the
options each time you deactivate the printer service.

When you're ready to print:

v on the Printer Service install sheet, select the name of the printer and tap
Connect On to tell PenPoint you've attached the printer to the computer

v choose Print from the Document menu and select the printer you want to
use.

If you leave the printer connected,
the next time you choose Print,
PenPoint will try and print the
document. If you won't be
connected to a printer and you
want the document to go to the
Outbox instead, select Connect
Off on the Printer Service install
sheet when you've finished printing.

The procedure for setting these options will change in Beta. jm September 29, 1990

GO Confidential Using the GO Computer
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Connecting an External Serial Device

When you're something other than a printer to the computer, you choose
settings for on in the Device notebook's Port sheet. For example, you'd set the
baud rate for external modems and external serial devices such as plotters there.

Information to be included in Beta release jm September 30, 1990

Using the GO Computer
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CHAPTER 4

Creating and Using
Documents




When you install a program in your notebook, PenPoint automatically places
stationery for that program in the Stationery notebook and on the table of
content’s Create menu .

You can think of stationery as a box of paper that never runs out. To create a
new document you start at the table of contents and choose a piece of
stationery from the Create menu. If you find that you routinely use a few kinds
of stationery, you can modify the Create menu by changing settings in the
Stationery notebook.

Most of the time when you create a new document, you’ll work with a full-page
document. But at times you may want to work with two documents at the
same time, for example to compare information. You do this by floating one
document above another. Floating a document temporarily detaches it from the
notebook. When you're finished working with it, you close it and it returns to
its place in the notebook.

While working on one type of document, you may want to add information
using different stationery. For example you might add a drawing to a written
report. You can do this embedding another piece of stationery in your
document. You can also prepare documents separately and combine them later
into one document.

USING THE GO COMPUTER GO CONFIDENTIAL
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CREATING A DOCUMENT

Using the Create Menu

~ Your GO Computer comes with some stationery already on the Create menu.

To create a new document from the menu:

Sampe_No

B
g
3
s
g

13
e
|
g
—
<
3
3
g
£
&

1 In the table of contents, tap to see
the Create menu

2 Tap to choose a piece of stationery

4 PenPoint inserts the new
document before the current
selection.

When you create a new document, PenPoint places it at the end of the table of
contents. To insert it at a specific location, tap the document title in front of
which you want to add a new document, and then choose a piece of stationery.

PenPoint inserts the document where you drew the tip of the caret. To insert a
new document between two documents, draw the tip in the space between the
documents. To insert it in a section, align the gesture with the documents in

that section.

GO CONFIDENTIAL
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As a shortout, you can draw a A on the
table of contents where you want the new
document to go. Fenpoint displays the
Create menu floating over the Table of
Contents. Tap to choose a piece of
stationery.
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CREATING A DOCUMENT
USING THE CREATE MENU

Using the Stationery Notebook

The stationery notebook holds all the stationery installed on the GO
Computer. If a program has more than one kind of stationery it’s listed beneath
the program name. You can flip through the notebook to see the different kinds
of stationery, or jump to a specific page by tapping its page number.

1 Start from the Notebook Table
of Contents. Tap the Stationery
notebook on the Bookshelf to

open it.

snapshot
User Test Fields
8 Handwriting Training

% Tap-hold on the name of the

stationary you want to copy.

& When you see the animated line
surrounding the title, drag it where
you want it to appear on the

Notebook Table of Contents.

SUBN0D
[ Gams | cowiovd | anwiod | swowod

PenPoint inserts the new document where you lift your pen. To insert a
document in a section, drag the stationery to a location within the section.

USING THE GO COMPUTER GO CONFIDENTIAL
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CREATING A DOCUMENT
USING THE CREATE MENU

Adding Stationery to the Create Menu

You use the Stationery notebook to choose which kinds of stationery to add to
the Create menu. Use the column of checkboxes under the heading “Create
Menu” on the Stationery notebook’s table of contents [[term??]].

1 Tap the Stationery notebook icon
on the Bookshelf to open it

2 To add stationery, tap an empty box
4 You’ll see a checkmark

sadu o] souapiedsg s3]

e

To remove it, tap again

If you don’t see the boxes, draw an M on
the title line to display the table of
contents menus and select the Create
Menu Box command in the Show menu to
display them.

GO CONFIDENTIAL CREATING AND USING DOCUMENTS
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CREATING A DOCUMENT

Renaming a Document

When you create a new document PenPoint gives it the name of its stationery.
To give it a more useful name:

v

v

v

v

use the Rename command in the table of contents menu, or
edit the title on the table of contents, or
edit the title on the document title line, or

change the title on the document option sheet.

Changing the title in one place automatically changes it in the others. For
example, if you edit the title with the Rename command, you’ll see the new
title when you open the document option sheet.

. s 'r—
| New Product

1 Tap Rename from the Edit menu

e

| oN['poid_poddoia]poud juan|haioo

2 Tap the <cross-out> button to clear
the pad and write in a new title

Or, edit the title in the editing pad

(If you need more room to write,
drag the right handle to widen it or
the botton handle to lengthen it)

3 Tap the OK button to see the new
title in the editing pad and tap
again to translate it to the page

Tap the <dismiss> button to close
the pad without renaming the ttle

USING THE GO COMPUTER GO CONFIDENTIAL
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CREATING A DOCUMENT
RENAMING A DOCUMENT

If you’re working on the table of contents, you can rename a document by
changing it in the editing pad. To do so, draw a circle O on the title to display
the editing pad, and change it there. If you’re working on a document, you can
rename it using the same shortcut. Draw a circle O on the title line to display
the the editing pad, and then change it.

For more information about changing editing in pads or fields see “Editing
Labels, Document Titles, and Fields” in chapter 6 (Editing and Formatting
Text).

GO CONFIDENTIAL CREATING AND USING DOCUMENTS
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CREATING A DOCUMENT

Customizing a Document

You can change the document options for different tasks. For example, if you
embed a pie chart in a report, you may choose not to display the title or menu
line so you see how the page will look when it’s printed.

You can decide whether to:

v

L
v
14

show the title line, menu line, scroll margin, or borders
disable editing so that a document can’t be changed

shorten the time it takes to turn to a document

add a cork margin where you can insert goto buttons and embedded
documents.

1 Drawa check ¥ on the document
title
4 You’ll see the Document option
sheets

2. Tap on the arrow in the title line to
see the other sheets

3 Tap to select each option you want

4 Tap to apply the options to the new
document and close the optlon
sheets

USING THE GO COMPUTER GO CONFIDENTIAL *
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CREATING A DOCUMENT
CUSTOMIZING A DOCUMENT

Each program you install on the GO Computer may add its own options to the
document option sheets or remove inappropriate ones. For example, you
wouldn’t need an Author field for the clock accessory.

You’ll find explanations for how to disable editing, get quicker access to
documents, and use the cork margin in Managing the Notebook chapter 8.

You can algo display the document option
sheets by choosing About from the
Document menu.

GO CONFIDENTIAL CREATING AND USING DOCUMENTS
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DISPLAYING AND POSITIONING DOCUMENTS

Scrolling a Document

If 2 document doesn’t entirely fit on the screen you can use flicks to navigate

within the document and bring different portions into view. You draw flicks in
the body of the document to scroll the document to the beginning or end or to
any point in between.

on babaganoush that] think will :
-term shelf storage. It m}l:lgt

tbem ‘with garlic’
curmtly have some § mblems witl
1o the top of :ﬁi jar, :
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isa good stable
0 well in cldo

on babaganoush that.l ﬂnnk mllstand up well o
long-term shelf storage. [tinvolves roasting the
eggplanis (which'we can. do in'bulk) and then’ smashmg
the ith emon, olive oil and spices. We -

ntly have'some probl . ith'the oil sepa!atmg out’

This js mhally a barbecu!sauce Gullxng 3
barbecuing vegetables like eggplantand zucchini and
other squash has becomi¢ very poptlarin ‘the West |

as you grill them. Pete in the test kitchens came up with
a clever way to make sure the sauce is thick ‘enough to -
on the' vegehbls yeuhm enough o look ap_palm

n gmtproduct. lts eggplant puree tmxed with gadic:

Eupl fentrees

Prepasing eggplanitis tedlou.s work, To my knowledge,

there is no'ready-to-cook eggplant product presently on
the market Frozen'or vacuum-packed breaded eggplant !
steaks could be used as a substitute for chicken or veal

cudes in many recipes. In Fact, we could !ake this oné

tothe top of the jar, which: very unappeuzmg, b'utl m

Yoi'd spread this cutry sauce over the vegetables.
X g" :

one, bu its acmally _

| anywhere in the document to
display the beginning of a document

I to display the end of a document

Flick up | to bring this line to the
top of the screen

Flick down | to bring the line to the
bottom of the screen
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DISPLAYING AND POSITIONING DOCUMENTS
SCROLLING A DOCUMENT

Drawing flicks is like using the eraser on a pencil to move parts of a page closer
to you. You pull the page toward you (flick down) to see what’s at the top, or
push it away (flick up) to see what’s on the bottom.

The scroll margin is useful for gauging your location in the document, and for
jumping to a specific location in it.You may find it easier to drag the <scroll
handle> to go to a specific part of the document. For example, if you were on
page one of a four-page report, to get to the third page, you could drag the
scroll handle about three-quarters of the way down the margin.

The position of the scroll handle

indicates your current location

S

2
W

IR

Drag the scroll handle to move to
the middle of the document

_ &sqdmpslmau ;g__mulswa;uog

February 17, 1991

ok ket c uo? Or, tap here to move to the middle
ur samples omemo:ﬁenokythmbeom .
ng our line. He briefly left the box on the kitchen of the document

fl where his ran into it with a icycle.

roke; spxll.mg thexr oom:uts all over

a'gota chancetolry ‘ou‘r ptoduct." :

| clable, 8oz plastic. - 7
ak under modemate impact? I'libe 1}
¢ . butyou can fax me suggst:d i
> sals at415/ 345.

9833,
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DISPLAYING AND POSITIONING DOCUMENTS
SCROLLING A DOCUMENT

The scroll arrows let you move either one line at a time or in a continuous
scroll:

v Tap the bottom arrow to see more of the page below
v Tap the top arrow to see more of the page at the top

v Press either arrow to scroll the page continuously

USING THE GO COMPUTER GO CONFIDENTIAL
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DISPLAYING AND POSITIONING DOCUMENTS

Floating a Document

When you detach a page from the notebook it floats on top of the current
page. It continues to float even as you move around the notebook, until you
close it. When you close it, it returns to its place in the notebook.

Floating one document above another allows you to compare and work with
both documents without flipping between pages.

Before floating a document you must first select the option for floating
documents in the Preferences option sheets. You only need to set this option
once to be able to float documents any time you use the Notebook. To set the
preference for floating On:

% Tap to open the Preferences options
sheets

2 If the Misc sheet isn’t displayed, tap
the arrow on the title line and
choose Misc from the menu

3 TapOn

an ubsdubiseq auiog|siamorsno] 50105 (s 7ept [ seion [ patd paodaud ]
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DISPLAYING AND POSITIONING DOCUMENTS
FLOATING A DOCUMENT

If you’re working on the table of contents and want to see what’s in a
document, you can float it on the table of contents, and then close it to put it
back in its place in the Notebook.

Double-tap its page number

‘pod

4 To close it, tap the close corner

L =
a_aiog | ssauioisn3| a1 o5 (s opi[saion [ poud_pasodaid

stable ve geuble Letme know what you

To detach and float one document above another document, double-tap the
Contents tab to float the table of contents, and then double-tap the page
number of the document you want to float.

If you’re working with several floating documents, and the one you want to
work with next is partially hidden, tap its title line to bring it to the front.

If you float a document and then turn to its page in the notebook, you’ll see the
document floating on a blank page.

You can algo float a document by
double-tapping its title line, tab, or GoTo
button.

USING THE GO COMPUTER GO CONFIDENTIAL -
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DISPLAYING AND POSITIONING DOCUMENTS

Moving and Resizing Floaters

In addition to documents, option sheets, and auxiliary [[term?]] notebooks
(such as the Stationery notebook) float. If the floating object is covering
information you want to work with, you can move or resize it.

: :»ok é_ﬁo&i
.1} ordering
oor

Our Hpties should be able to withstand the impa froth 2
ticydje powered by g three yearold, But four bo

gf_~

‘ournew

salsa broke, spilling their contents all over the

uo:sna[ﬁng{smm [ a1 ‘paud pé&odd.u [poad “Juaun) | sjuajuo;

To move a document or notebook,
press the title line.

Wait until the border of the title
line darkens which tells you it’s
ready to be moved.

Drag it to its new location.

To resize it:

4 Drag the corner handle to the
right to widen it; to the left to
narrow it

To expand or reduce the page area
/ in both directions, drag here

4 Drag the bottom handle down to
lengthen it, or up to shorten it

If you re-open a floating document after resizing or moving it, PenPoint
displays it as you last left it.

GO CONFIDENTIAL
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To move an option sheet, drag the gray
border. (You don't have to press before
dragging it.)
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DISPLAYING AND POSITIONING DOCUMENTS

Zooming a Document

When you want to use the entire screen area to display a document, you can
zoom a floating document so that it covers the tabs and the title and menu
lines, thus enabling you to work on a larger area of the document. When you
shrink it, it returns to its previous size.

Before zooming a document you must first choose the zoom option in the
Preferences icon. You only need to set this option once to be able to zoom

documents any time you use the GO Computer. To set the zoom preference to
On:

1 Tap to open the Preferences
<option sheets>

% If the Misc sheet isn't displayed, tap
the arrow or name at the top to see
the menu and select Misc

" ubisq ubisaa apoq| siawioisno | 5395 [s vop[ soion | o

3 TapOn
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DISPLAYING AND POSITIONING DOCUMENTS
ZOOMING A DOCUMENT

1 To zoom a document, draw a flick
up | on the title line. Make sure the
flick begins in the title line.

4 To return the page to its normal
size, draw a flick down |.

ubsag :ajuog Lmamo;shglsam;lsmq[sam ‘paiy: pasodoug [pma»_;&a.ﬂna[quamo:;@

If you've enlarged the document and want
to turn to another page, shrink it first to
display the page number menu and tabe.

GO CONFIDENTIAL CREATING AND USING DOCUMENTS
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USING COMPOUND DOCUMENTS

Embedding a New Document

Another way to work with more than one document at one time is to embed
one document inside another. This creates a compound document and is most
useful when, for example, you want a drawing, graph, or information from a
spreadsheet to appear as part of a written report. There are two ways to create a

compound document:

v create a new document within another document

v move or copy an existing document into another document.

1 Start from the document in which

you want to embed another

| Draw the embedded document

gesture & where you want the new
document to go

You'll see the Create menu

Tap to select the stationery you
want to use

PenPoint embeds a new document
of the appropriate type where you
drew the tip of the gesture. You can
work in it in the usual ways.

4 To open more of the document,
tap the icon

4 To close the document tap the
close corner

4 To delete the document, draw a
cross out X on the title line if it’s
open or the anchor if it’s closed

(partial screen) letter with double chevron drawn below the first sentenced; tap on Draw document; text
editor document; (partial screen) showing letter with Draw doc embedded and leader line to anchor

figure U4-13

USING THE GO COMPUTER
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USING COMPOUND DOCUMENTS

Embedding an Existing Document

You may find it more convenient to work on documents separately until you’re
ready to assemble them, at which point you can copy or move one document
into another. Or, you may just want to put a copy of an existing document into
another.

1 Start from the document in which
you want to embed another

2 Double tap .. the Contents tab to
float the table of contents

2 Move the title of the second
document to the place you want to
insert it in the first

Notice that the document you
moved is no longer listed on the
table of contents.

(2 screens) (screen) 1)memo with Table of Contents floating on it; Capers doc being dragged to below
eggplant surprise  figure U4-14
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USING COMPOUND DOCUMENTS

Working with Embedded Documents

Setting Document Options

You set document options for an embedded document in the usual way (draw
a checkmark on the document title line).

If the title line is hidden, draw a check tap v anywhere on the document.

Moving an Embedded Document

You can move an embedded document to another location in the same
document by dragging it to another location. Use the {{press hold}} gesture on
the title line or, if it’s closed, on the anchor. To move an embedded document
to a different page, float the document to which you want to move it.

GO CONFIDENTIAL -
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WORKING WITH

Floating an Embedded Document

USING COMPOUND DOCUMENTS

EMBEDDED DOCUMENTS

You can decide whether to float the document on the page when it’s open, or

have it stay where you inserted it. To choose these options:

1 Drawa check ¢ on the title line (or

on the icon if it’s closed) to display
the document option sheets

If it’s not displayed, tap the arrow
on the title line to see the other
option sheets. Tap to select the
Access option sheet.

Choose in place if you'll usually
work with the document where you
inserted it

Choose floating to see information
in the embedded document while
working in another part of the
larger document

(partial screen) memo showing capers doc; checkmark on title line; (object) access sheet of doc options

figure 4-15

If you choose floating , when you turn the page, the document stays on its
page. If you choose in place , you can still float the document by
double-tapping its title line. But when you turn the page, it floats on the new

page.

You work with floating embedded documents in the same way you do a floating
full-page document. To resize it, drag the handles, to move it press hold and
then drag the title line, to close it tap the close corner. When you close it, it

returns to the insertion point.

GO CONFIDENTIAL
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USING COMPOUND DOCUMENTS
WORKING WITH EMBEDDED DOCUMENTS

Making an Embedded Document a Full-page Document

You can reverse the procedure and split compound documents into two
separate documents. For example, if you decided you didn’t need to illustrate
sales results with a graph, you might want to remove the graph from the report,
but keep the graph in the notebook.

To copy or move an embedded document to a separate page, {{press hold}} the
title line of the embedded document (or the icon if it’s closed), turn to the table
of contents, and drag the document to a location on the table of contents.

Where you lift the pen tip determines where the document goes.

v To insert the document between two documents, lift the pen in the space
between the documents

v To place it in a section, lift the pen when it’s aligned with the other
documents in the section

v To place it outside a section, lift the pen when it’s aligned with the left
margin.

USING THE GO COMPUTER GO CONFIDENTIAL
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USING COMPOUND DOCUMENTS
ORKING WITH EMBEDDED DOCUMENTS

Printing an Embedded Document

When you print the larger document, only the part of an embedded document
that’s showing at the time gets printed. To print a portion of an embedded
document within the larger one, resize it before you print. If you want to print
the whole thing choose Print All Contents on the Print Setup option sheet.

Select Print All Contents to print
the entire document

If an embedded document is near
the end of a page, select Keep on
Page to prevent the contents from
being split between two pages

To make sure that an embedded
document always begins on a new
page, select Begin on Page

(object screen) Print Setup Layout sheet with print all contents selected and begin on new page figure
U4-16

To print the embedded document without printing the document that contains
it, choose Print from the embedded document’s Document menu.

The larger document’s Print Setup option sheets set the orientation and paper
size for the embedded document and supress other Print Setup options for the
embedded document, such as margins, headers, and footers.

If you want to format the embedded document with its own margins and
header and footer information, set the appropriate Print Setup options for the
embedded document and then select Print All Contents. PenPoint prints the
embedded document starting on a new page using the settings you've selected
and then returns to the options for the document that contains it.

You’ll find more details about the Print Setup options in Printing, Sending, and
Receiving Documents (chapter 9).

If the embedded document is closed, it
isn't printed at all. To avoid printing the
icon, move the document to the cork
margin. You can find out how to use the
cork margin in Managing the Notebook
(chapter 8.)

CREATING AND USING DOCUMENTS
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STATIONERY

Creating Stationery

You can use the stationery from the Stationery notebook as it is set up, or you
can change the margins, the font and other options. If you routinely change
options you can customize a piece of stationery and add it to the Stationery
notebook. For example, you might create stationery for a weekly report that
would have preset margins and an embedded spreadsheet.

To set text options, such as the font for a document, write text on the page and
then style and format it appropriately.

USING THE GO COMPUTER GO CONFIDENTIAL
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STATIONERY
CREATING STATIONERY

Creating Customized Stationery

1 Tap to open the Stationery
notebook, which is where you’ll
create the new piece of stationery

2 Select a location in the Stationery
notebook table of contents for the
new document

3 Tap to open the Create menu and
tap the stationery you want to
customize

(If you don’t see the table of
contents menus, draw an M on the
title line to display the menus.)

4 A piece of stationery is added to
the stationery notebook

£, Name the new stationery in the
usual way

%  Turn to the new document in the
Stationery notebook

& Draw a ¥ on the title line and select
the options you want included in
the customized stationery

1 & 2. (screen) stationery notebook with title selected, create menu open and text editor memo selected

3 & 5. (screen) of new stationery doc, ¥ on titie line, doc option sheet with cork margin selected figure
U4-17

Once you've created stationery, you can
further modify it by turning to it in the
Stationery notebook and making the
necessary changes there.

GO CONFIDENTIAL CREATING AND USING DOCUMENTS
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STATIONERY

Managing the Stationery notebook

You manage the Stationery notebook from its table of contents just as you do
the basic Notebook. You can rearrange the stationery titles, group related ones
together, rename them, and delete the ones you no longer need. (If you don’t
see the table of contents menus, draw an M on the title line to display the
menus.)

To rearrange the order:

v press drag to move a piece of stationery to another location

To group stationery into sections:

v Select a location on the table of contents

« Choose Create Section from the Create menu

v . to expand the section

« DPress drag to move a document where it says “Empty”

To attach a tab:

v Choose Tab from the Show menu and tap the checkbox next to the title
To rename stationery:

v Draw a O over the title to display the editing pad and change the title.
To delete stationery:

v Draw a X over the title

You can find more detailed instructions for these procedures in “Managing the
Notebook” (chapter 7).

USING THE GO COMPUTER

26

GO CONFIDENTIAL

SEPTEMBER 26, 1990



GO CONFIDENTIAL

MOVING AND DELETING DOCUMENTS

To manage your notebook efficiently you can remove documents you no longer
need. If you want to use a document at some future date, move it to a floppy or
hard disk instead of deleting it. If you know you’ll never use it again, you can
delete it.

To delete a document:
v Draw a X on the title in the table of contents or the document title line

¢ Or, select the document in the table of contents and choose Delete from
the Edit menu.

Before deleting a document, decide whether or not you want to keep a backup
version of it on disk. You can find out how to make backup versions in Filing
(chapter 10).

When you delete a document, PenPoint asks you whether or not you want to

delete the document. To go ahead, tap Delete. To change your mind, tap
Cancel.

object screen of the delete confirmation message  figure U4-18
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Printing in Writing Fads

You write in the notebook on a writing pad as you would on a paper pad.
When you’re done, the Lombard converts what you've written into typed,

electronic text which you can then easily correct and edit.

Writing pads vary in size to accommodate different writing tasks. Some pads are
already on the page when you create a new document. For example, a writing
pad automatically appears on newly created Text Editor documents. Others,
such as the line pad, pop up when you want them.

Printing in the Writing Fad

Writing pads contain separate boxes for each character. After translation the
characters remain in their boxes so you can correct them before you translate

your printing to the page.

o Texwdw

Documem Edit lnsen

Case format

If you normally print in upper case, open
the Preferences option sheets and
choose the All Caps option from the
Handwriting option sheet.

USING THE GO COMPUTER
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Start the letter in the character box
and print clearly

Wrrite naturally; the Lombard will
keep up with you

Leave a space between words (if you
finish a word in the last character
box, skip a box on the next line
before starting the next word)

You can cross your t’s and dot your
I’s after writing a line and before
starting a new one

Draw a scratch out 2 when you
want to erase something you’ve
written

To start a new paragraph, leave a
space between lines

GO CONFIDENTIAL
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When you print a descending letter such as a “g”, it goes into the box below it.
You can write in this box when you get to it.

If you can't fit a word at the end of the line, don’t hyphenate it or PenPoint will
translate the hyphen. Scratch it out and write it on the next line. PenPoint
translates the extra spaces you leave at the end of the line into a single space.

Sometimes when writing you’ll make the first letter of a word larger than the
others. You'll get more accurate results if you make the upper and lowercase
letters a consistent size.

<Handwriting Appendix> offers further tips on handwriting,

At some point you may find it easier to
write on ruled pads or to use a keyboard to
enter text. To learn how to use a keyboard
and adjust the style, size, and shape of the
pads, read “Using Writing Pads” in this
chapter.

GO CONFIDENTIAL WRITING IN THE NOTEBOOK
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Translating Your Handwriting

At any time you can translate your printing in the writing pad. This allows you
to see whether the letters are correct before you tell PenPoint to translate them
to the page.

Tap the translate button when
you're ready to translate your
writing on the writing pad

If PenPoint mistranslated any
letters, you can correct them in the
writing pad

When you’re ready to transfer the
letters to the page, tap the translate
button again

To get the best translation results:
v Align the pen with the Pen sheet of the Preferences notebook.
« Review the handwriting tips in <Handwriting Appendix>

v Train PenPoint some more with Handwriting Training which you’ll find in
the Accessories notebook.

The single character pad translates
your handwriting automatically when
you lift the pen away from the screen.

USING THE GO COMPUTER GO CONFIDENTIAL
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Correcting the Translation

I the Lombard mistranslates a word, you can correct it in the writing pad
before you transfer what you’ve written to the page. Or, you can wait and

Correcting the Translation in the Writing Pad

correct it later on the page with the proof sheet or with editing gestures.

If PenPoint doesn’t recognize a letter, it replaces the letter with a {{circle
questionmark}}. To correct unrecognized or mistranslated letters:

GO CONFIDENTIAL
SEPTEMBER 26, 1990

Write over a mistranslated letter
Or, use gestures to correct it.

When you draw a gesture, begin it
within the character box and end it
outside the box. Otherwise, the
Lombard will try to interpret your
gesture as a letter.

Insert a space with the L The size of
the space depends on the length of
the bottom of the gesture.

Draw a vertical pigtail ¥ to delete
unwanted characters

Draw a horizontal line through the
letters you want to delete

WRITING IN THE NOTEBOOK
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CORRECTING THE TRANSLATION

Correcting the Translation with the Proof Sheet

If you need to correct a word on the page, you can often find the correct word
on the Proof sheet.

1 Draw a P over the incorrect word to

display the proof sheet

2 Tap to select the correct word from
the list of suggested alternatives

3 Ifone of the alternatives is close to
the word you want, double tap ..
the word to put it in the editing
pad and display a list of further

alternatives.

Or, edit the characters in the
editing pad.

4 Write over a mistranslated letter.

4 Or, use the same gestures you use
to correct the text in the writing
pad.

4. Tap to translate the text in the pad
and tap again to replace the
incorrect word with the corrected
one

The list of alternatives may include combinations of letters PenPoint doesn’t
recognize as a word, since the word you wrote may be an acronym or personal
noun not found in its dictionary. Selecting it on the Proof sheet adds it to the
personal dictionary so that the next time you write the word, PenPoint will
translate it correctly.

It’s sometimes easier to correct the translation directly on the page, particularly
when only one or two characters are mistranslated. You can read about editing
gestures that let you correct and revise the text in “Editing and Formatting
Text” (chapter 6).
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Using Writing Fads

Getting a Writing Pad

To get a character pad, draw a insert
character I”

To get a line pad, draw a caret A

4 To increase the writing area, drag
the handle to the right to widen
the pad, down to lengthen it. Do
the opposite to decrease the
writing area.

4 Tap anywhere outside a character
or line pad to dismiss it without
translating what you’ve written

To get a paragraph pad, draw a
caret tap A

dw ps| souauada fsai | siuz

/ Drag the handle down to expand

the writing area.

4 To close it, tap the translate
button if it’s empty (if it’s not,

draw an X on the translate button
to clear it)

N $9]

If you are working in a Text Editor
document, you can insert writing pads by
selecting the appropriate pad from the
Insert menu.

GO CONFIDENTIAL WRITING IN THE NOTEBOOK
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USING WRITING PADS

Some pads don’t have translate buttons or resize handles. They’re designed for
the specific task, such as adding a single character or writing text in a field.

When you want to add several words to a document use the line pad. Insert a
paragraph pad to add several sentences. The paragraph pad begins where you
draw the gesture and stays open so you can continue using it. When you need
more room to write, drag the bottom handle down.

USING THE GO COMPUTER GO CONFIDENTIAL
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USING WRITING PADS

Choasing a Writing Fad Style

Once you get used to writing in the notebook, you may find it more
convenient to write on a ruled pad. Ruled pads differ from character box pads:

v PenPoint doesn’t translate the writing in the pad before transferring it to the
page. You correct what you've written by drawing a <scratch out> gesture.

v The pad is only intended for handwriting. (If you’d rather enter text with
the keyboard, you can do so in the document.)

1 Tap Preferences to open it and tap
Ruled on the Handwriting Sheet

N\

A

SSN

'_*'Q

2 Write naturally. Leave space
between words or draw a <??> to
insert a blank space.

N

4 Draw a scratch out 2 to erase
what you’ve written

4 Draw a cross out X on the
translate button to clear the pad

3 Tap the translation button to
transfer your writing to the page

Jw s souauiadyg ssad [ S1usiuod KRN
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USING WRITING PADS

If in translating your printing to the page, PenPoint doesn’t recognize a letter, it
replaces the letter with a {{circle questionmark}}. You can correct mistranslated
words with editing gestures or the Proof sheet. You can find out how to correct
words in the Proof sheet in this chapter and an explanation of how to edit text
.« .. . »

in “Editing and Formatting Text” (chapter 6).

When writing on the ruled pads, you can get the best translation results, if you:
v write as neatly as you do in the character boxes

+ leave a consistent amount of space between characters and words (leave
more space between words than you do between characters)

v make your uppercase and ascending letters (“h”, “d”) a consistent height

and your lowercase letters (“a”, “1”, “c”) a consistent size

v write vertically rather than on a slant. PenPoint sometimes translates
overlapping letters as one letter.

v connect the strokes that you make to form a letter, such as a “t” or “k”.
Otherwise, PenPoint may translate each stroke as a separate character.

The <Handwriting Appendix> offers further tips on handwriting.

You can adjust the shape, size, and spacing for either ruled or character box
styles. Change the style on the Handwriting sheet of the Preferences notebook.

USING THE GO COMPUTER GO CONFIDENTIAL .
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USING WRITING PADS

Using a Keyboard to Write

At times you may find it easier to type in the writing pad instead of printing in
it. You can use PenPoint’s software keyboard or a regular keyboard that you
plug into the GO QuickCharger.

To use the software keyboard:

1 Tap the keyboard icon(if the
keyboard icon is not visible, open
Accessories notebook and tap the
keyboard icon)

2 Tap a character on the keyboard

PenPoint inserts it in the first
character box

4 To type an upper case letter, tap
the shift key and then the
character you want. Tap the shift
key again to return to lower case.

4 To change a translated character
in the writing pad, tap the
character box to make it active,
then tap the appropriate key on
the keyboard

7

- F

3 To move the keyboard, press and
drag the title line

4. Tap to close the keyboard

When you use the keyboard to insert text in a writing pad, field, or on the page,
you first tell PenPoint where to begin typing.

In a writing pad the current character box is highlighted. To select another
location, press hold a different character box. When you start typing, PenPoint
replaces the contents of the character box. If you continue typing, it replaces
the contents of the next boxes as well.

To tell PenPoint where to begin typing in a field, press hold the space between
letters. On a page, tap the space between letters.

GO CONFIDENTIAL WRITING IN THE NOTEBOOK
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USING WRITING PADS

Depending on your writing task, you may want to choose a different keyboard
layout. Draw a check on the title of the current keyboard and tap to select an
alphabetical or PC compatible layout or a numeric keypad.

To use a regular keyboard, plug it into the QuickCharger and follow the same
procedure for typing in a writing pad as you do for the software keyboard. You
can find a diagram for how to attach the keyboard in “Setup and Care” (chapter

<??>).
PenPoint doesn't use the function, {Alt},
and {Ctrl} keys on the keyboard.
USING THE GO COMPUTER GO CONFIDENTIAL
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Training the Lombard in Your Handwriting
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EDITING TEXT

Selecting Text

Sometimes the object of your commands is obvious. For example, to delete a
single word you draw a cross out X over it. At other times, you need to tell
PenPoint what to act upon by first selecting it. For example, to delete a whole
paragraph, you first need to select it.

To select a whole unit of text press
hold a character to select it

Double tap to select a word
Triple tap to select a sentence
Quadruple tap to select a paragraph

To select the entire document,
choose Select All from the Edit
menu

(Screen: first 3 paragraphs of letter);

1st para: press hold on “W" of “new”; double-tap on word “plastic”

2nd para: triple-tap on last sentence “He briefly...”

3rd para: quadruple-tap to select entire para
ue-1

You can specify how much text is selected with two other gestures.

Press and drag to select the text
from the first character you touch
to wherever you lift the pen

Or, draw brackets [ ] to select
enclosed text

4 Redraw (left bracket) [ to adjust
the selection

(partial screen) Southwestern curry para of memo

press drag through “like eggplant and zucchini and other squash”

same sentence with same selection done with brackets

same sentence with bracket redrawn so that “like eggplant and zucchini” is deselected
figure U6-2

When you first draw the brackets or later redraw them to expand the size of the
selection, PenPoint selects the text by whole words. If you redraw the bracket to
make the size of the selection smaller, you can draw the bracket in the middle
of a word. This is useful, for example, when you want to select text without the
punctuation that follows it, such as a colon or period.

USING THE GO COMPUTER GO CONFIDENTIAL
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EDITING TEXT

Editing Text within a Document

Adding Text

To add text to a document, you use a writing pad. You have a choice of three
sizes of pads: single character, line, or paragraph. Choose the one that best fits
the amount of text you want to add.

To add one character, draw a insert
character I

PenPoint translates your writing
when you lift the pen away from
the screen

To insert several words, draw a caret
A

If you need more room to write,
drag the handle to the right to
widen it or the bottom handle
down to add more lines

To insert several lines of text, draw a
caret tap A

Tap the translate button to translate
your writing in the pad, tap again
to transfer it to the page

PenPoint inserts the text where you

drew the gesture to get the pad
(series of partial screens based on SW curry para in short memo)
1st: show 2nd sentence with only one “r" for “curry” and up right gesture with “r" written in char box;
2nd: show 2nd sentence without the words (as you grill them) and caret before the period with (as you
grill them) written in line pad
3rd: show caret tap after second sentence with socme of remaining text from long memo written in it
figure U6-3

The paragraph pad stays on the page so that you can continue adding more
text. When you’re finished using it, tap the translate button. (If you want to
close it without translating what you've printed, first clear the pad by drawing a
cross out X on the translate button, and then tap the translate button.)

To make a new paragraph, leave a blank line
at the top of the writing pad.

GO CONFIDENTIAL EDITING AND FORMATTING TEXT
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EDITING TEXT
EDITING TEXT WITHIN A DOCUMENT

Deleting Text

The delete gestures operate directly on a word or a selection. You can use them
to delete text in a document and in a field.

Draw a cross out X to delete what’s
beneath the gesture

Draw a vertical pigtail # to delete a
single character

Draw a horizontal pigtail < to
delete one or more words on a line

Show paragraph of text with following deletions:

Use last para of lefter (Can you heip us design a lightweight... add a “c” in front of lightweight and the
word “to” before the word “design”):

cross out through “to”, vertical pigtail through “c”, horizontal pigtail through “recyciable 8 oz"

figure U6-4

Inserting Spaces in Translated Text

To add a single space, draw a insert
space L

Repeat this gesture to add more
space.

Show first sentence of contract with no space between *a” and “new".
figure U6-5

USING THE GO COMPUTER GO CONFIDENTIAL
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EDITING TEXT

Editing Text in Editing Fads

Once you've translated the text, you can change the text on the page, correct or
replace the word in an editing pad. Use the editing pad when only a few
characters need to be corrected. Replace the text when it’s easier to rewrite it
than edit it or when you want to substitute the text with new text.

series of editing pads showing gesture(results not necessary
Use: “It's cheap to grow and it survives well in cld sforaae, and various preparations of it seem to hold up

well on the snelt” from memo:

To edit a word:

Draw a circle O to put the word in
the editing pad

To edit it:

4 Write the correct letters over the
incorrect ones

4 Delete an individual character by
drawing a vertical pigtail &

4 Insert one or more spaces by
drawing insert space L

4 Delete several characters by
drawing a horizontal line —
through them

Tap the translate button to translate
your printing in the pad, tap again
to transfer it to the page

1. circle drawn over “snelt” with “h" overwritting the “n” and “f" overwriting the “"

2. show “cldo” in pad with vertical pigtail over “0”, insert space on the “I
3.show “sforaae” in pad with horizontal line from “f" through second “a”
figure U6-6
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EDITING TEXT
EDITING TEXT IN EDITING PADS

To replace a word:

1 Draw the replace gesture© over the
word to display an empty editing
pad

2 Write in the new word and tap the
translate button

PenPoint replaces the word with the
new one

series of editing pads showing gesture(results not necessary )

Use: “It's cheap to grow and it survives well in cid sforaae, and various preparations of it seem to hold up
well on the snelt” from memo:

circle-line over “survives” and "keeps” written in pad

figure U6-7

The size of the circle you draw determines the amount of text that PenPoint
places in the editing pad. You can draw the circle O over a word, or several
words.

Resize the editing pad by dragging the lower right-hand handle when you want
more character boxes to write in. (Resizing is explained earlier in this chapter.)

USING THE GO COMPUTER GO CONFIDENTIAL
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EDITING TEXT

Editing Labels, Document Titles, and Fields

Use an editing pad to change what you’ve written on:

tab, icon, and GoTo button labels

+ document and section titles in the table of contents

v titles in the document title line

v Forms, option sheets, and lists, such as the {Send List}
1
2

series of editing pads showing gesture(results not necessary):

show ©over “New Uses for Eggplant” in table of contents

circle over Eggplant; word in editing pad and leader line to delete button
empty pad with the word printed “squash”

figure U6-8

GO CONFIDENTIAL
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Draw a circle O to put the text in
the editing pad

To edit it:

4 Clear the pad by tapping the {{x
button}} and then write in the
new text

4 Write the correct letters over the
incorrect ones

4 Or edit the text with:

4 2 vertical pigtail & to delete a
single character

4 3 horizontal line — to delete a
series of letters

4 Lro insert space

Tap the {{OK button}} to translate
your printing in the pad; tap it
again to replace the text on the label

or field

4 To dismiss the editing pad
without translating your printing,
tap the {{circle slash button}}

EDITING AND FORMATTING TEXT
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EDITING TEXT

EDITING LABELS, DOCUMENT TITLES,
AND FIELDS

Editing Fields

Generally, you'll enter and change text more often in fields than you do for
labels and document titles. There are several gestures you can use to quickly
change the text.

To delete the contents of the field
cross out X or scratch out 2 the text

To add text draw a caret A

To use the keyboard to add text,
first press hold to tell PenPoint
where to enter the text, then type in
the text

Write the correct number over the
incorrect one

Draw a circle O to put the text in
an editing pad and edit the word
using the vertical pigtail 7,
horizontal line —, and insert space
gesture L

(screen) order form (example will be a change of address for the company.

scratch out through Address; overwriting new zip code; caret on Name and “& Weber" added to name;

minor misspelling in contact name to show vertical pigtail and insert space
figure 6-8a

To quickly display an editing pad for a
field, tap its text. ‘

USING THE GO COMPUTER GO CONFIDENTIAL
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EDITING TEXT

Moving and Copying Text

GO CONFIDENTIAL

You can move or copy text within a document or to another document by
using gestures. For example, you can move a sentence or paragraph earlier in
your document, or copy a phrase that you want to repeat several times.

Moving or Copying Text

1 Select the text you want to move

2 Press your pen on the selection and
hold it there until you see an
animated line surrounding an icon
which shows the text (or a portion
of it, if the selection is longer than a
few words)

& Drag the icon to a location in the
document

use the contract; move the paragraph from the letter “Our bottles should be able to withstand"” to the
contract before item #1

(screen) contract with letter resized and floating on it and the para “Our bottles..” being moved to contract
figure U6-9

To cancel a move or copy, tap anywhere on the page before dragging the text

You copy text almost the same way. Select the text, then tap it, touch the pen to
the screen again and hold it until you see the icon. Then drag the copy to its
new location.

If you find it easier to use the menu commands, elect the text, choose Copy
from the Edit menu, and then drag it where you want it to go.

EDITING AND FORMATTING TEXT
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FORMATTING TEXT

Styling Text

You can change the appearance of text by using gestures or the text option
sheets to: change the text style to bold, italics, or underlined; choose a different

Styling Text Directly

font (the typeface); and turn upper case words into lower case.

You use gestures to style text directly on the page. If you select a range of text,
the gesture applies to the selection; otherwise, it applies to the word that lies

beneath it.

To style text directly, draw:
B to bold the text

| to italicize it

U to underline the text

N restores the text to its normal
settings by removing the bold type,
italics, and underlining

To increase the size of the characters
(in points) to the next point size
listed on the font option menu,
draw an arrow up #

To decrease the size of the
characters to the next point size
listed on the font option menu,
draw an arrow downV

To change the text to upper case,
draw a

To convert the text to lower case,
draw a™

To change the text to initial
capitals, draw a

3 column table: callout, “Southwestern curry sauce”, result. The same word should be shown with each

gesture drawn on it and the result to its right
figure U6-10

In Text Editor documents, you can also change the case by selecting the text
and then choosing the appropriate case from the Case menu.

USING THE GO COMPUTER
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FORMATTING TEXT
STYLING TEXT

Styling Text with Text Option Sheets

When you want to make several changes to a document or a range of text, you
might find it more convenient to use the Character option sheet.

T Select the text to style and draw a
check ¥ over the selection

2 Tap the arrow in the title line and
tap to display the Character option
sheet if it’s not already displayed

3 Tap to select an option

4 Some options present several
further choices. These appear on
pop-up menus.

4. Tap the appropriate action button
when you’re done, or tap here to
close the sheet without making any
changes

(screen) character option sheet popped up over Southwestern curry sauce paragraph, with
Southwestern curry sauce selected with small caps and underline selected
figure U6-11

You can also display the text option sheets by selecting text and choosing
Options from the Edit menu.

GO CONFIDENTIAL EDITING AND FORMATTING TEXT
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FORMATTING TEXT

Formatting Text

You can change the placement of text on the page by giving it paragraph
formats.

By using gestures or the text option sheets you can:

v set margins for the document

v insert tabs

v show information, such as the symbols which indicate a new paragraph

You’ll find information about inserting new lines, new paragraphs, and spaces
between words later in this chapter in “Inserting Spaces” and “Starting New
Lines, Paragraphs, and Pages.”

Setting Margins

% Select the text to format and draw a
check ¥ over the selection

2 Tap the arrow in the title line and
tap to display the Paragraph option
sheet if it’s not already displayed

3 Write in the amount in inches the
text should be indented from the
page margin

4 Tap the appropriate action button
when you’re done

(screen contract) with items 1-5 selected ;
paragraph option sheet floating; with 1.25 written in left and right margin to create indented paragraphs
figure UB-12

The page margins are set with the Print
Setup command.

USING THE GO COMPUTER GO CONFIDENTIAL
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FORMATTING TEXT

FORMATTING

Changing Line Spacing

TEXT

1

2

Select the text to format and draw a
check ¢ over the selection

Tap the arow on the title line and
tap to display the Paragraph option
sheet if it’s not already displayed

Increase the line height when you
have several fonts on a line and
want more space around the letters

Change the spacing between lines
by writing an amount in inches

Indent the first line of each
paragraph by writing an amount in
inches for the 1st Line Offset

Change the spacing between
paragraphs by adding space before
the first line of the paragraph or
after the last line

Tap the appropriate action button
when you’re done

(object screen) 2nd para of letter (A few weeks...) selected, checkmark drawn on para; para option sheet

floating with leader lines to Paragraph option sheet
figure U6-13

You might want to change the line spacing offset an embedded document on a

Fositioning the Text

page or to add space to a line if the font you’ve chosen looks crowded.

If you want the text to line up evenly on the right hand margin:

v display the Paragraph sheet of the Text Option sheets

v select Yes for the Justify option.

To change the placement of text on the page, select the appropriate Alignment
option on the Paragraph option sheet. For example, you might select Center to

place a title in the middle of a page.

GO CONFIDENTIAL
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FORMATTING TEXT
FORMATTING TEXT

Setting Tabs

1 Select the text and draw a check ¥/

over the selection

2 Tap the title line and tap to display
the Tab option sheet if it’s not
already displayed

3  Write a number in inches for each
tab stop

Draw a cross out X to delete a tab
stop

Draw a caret A to insert a new tab
StOp

To change the current tab, write in
a new number

4 Tap the appropriate action button
when you’re done.

(screen contract) items selected

tab option sheet tab option sheet with 1.00 written in for 1st tab stop and 1.5 written in for second tab stop
show result of items indented and numbers and text aligned (insert tab gesture on 1st item to show how
to insert the tab on the page)

figure U6-14

To insert a tab on a page, draw an insert tab gesture L before the text you want
to indent. PenPoint sets the tab stops based on the amounts you entered in the
tab option sheet.

USING THE GO COMPUTER GO CONFIDENTIAL
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FORMATTING TEXT
FORMATTING TEXT

Starting a New Line, Paragraph, or Page

When you start a new line, PenPoint moves to the beginning of the next line.
Use this gesture to add blank lines or to split an item on a list into two items.

When you start a new paragraph, PenPoint applies the paragraph formatting
options, such as the amount if any to indent the first line and the amount of
space to leave between paragraphs.

To make a new paragraph, draw an
insert paragraph gesture J

To insert a new line, draw an insert
new line gesture J

Show last para of letter “Can you help us..."” with a down-left drawn before “I'll be travelling..”
Show client address on letter with no space between the company name and street address and a
down-left-flick gesture to split line;

figure U6-14a

In Text Editor documents, you can also start a new line or paragraph by tapping
to select a location, and then choosing the appropriate command from the
Insert menu.

To insert a page break on a Text Editor document:
tap to set the insertion point

tap to select the Page Break command on the Insert menu

Copying a Format or Style

Sometimes you’ll want to apply the same format or style to a different selection.
For example, in a drawing of a floorplan you might want to change the pen
width and fill pattern you’re using for windows to match the one you used on a
previous drawing. To do this:

select the object which has the format or style you want to copy

AN

draw a check ¥ to display its option sheet

A

select the text or object to which you’ll apply the same settings
tap Apply

<

EDITING AND FORMATTING TEXT
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FORMATTING TEXT

Viewing Text

i
H

Viewi%ng Text

The View options display information on screen to tell you more about what's
on the page.

You get to the View option sheet in the usual way: select a range of text, draw a
check ¥, tap the name of the option sheet, and then tap to select the
appropriate one.

Shows symbols on the screen, such
as paragraph marks

Shows text that you hid with the
Hidden option on the character
option sheet

object: contract with hidden text added “Send J. Stanton's team a copy” at the top. Make sure there are
tabs between the number and the text, eg. tab between period and “Y" (1. You agree...)

all options should be selected and results shown

figure U6-15

To add notes or comments to a document which you don’t want to show or to
print, select the text and choose Hidden from the Character option sheet. To
view or print this text, choose Hidden Text from the Access option sheet.

Magnifying the Text

You can increase the size of the text by magnifying it. When you magnify text it
makes the letters bigger without increasing the font size.

To magnify text:
v draw a ¥ on a word to display the text option sheets
v tap the option name to display the View sheet if it’s not displayed

« tap to see the different magnification amounts and tap to select a
magnification size.

USING THE GO COMPUTER GO CONFIDENTIAL
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FORMATTING TEXT
VIEWING TEXT

Before printing a document, you may want to what it will look like when it’s
printed. To do so:

Choose For Printer to see how the-
page will look when it’s printed

(If you've set margins that are wider
than the GO Computer screen,
scroll to see the part of the
document that’s off the screen.)

Choose For Screen to see the page
as it usually appears on the screen

(object) letter with For Printer selected
(object) letter with For Screen selected
figure U6-16

GO CONFIDENTIAL EDITING AND FORMATTING TEXT
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FORMATTING TEXT

Checking Your Spelling

You can check the spelling of anything you’ve written in the notebook. For
example, in a document you can check the spelling of a single word, selected
text, or the entire document.

When you check the spelling of a document or selection, the spell dialog shows
each misspelled word in an editing pad. If you don’t find the correct word
among the alternatives, you can correct it in the editing pad using the editing
gestures described in “Editing Text in Editing Pads” in this chapter. Or, you
can write a new word over the old one.

1 To check the spelling of an entire
document, draw an S on the title
line

To check just a word or part of a
document, select the text and draw
an 5 over it

PenPoint displays the Spell dialog
and puts the first misspelled word it
finds in the editing pad

2 Tap. on an alternate word to
correct it and continue checking.

Or, edit the word in the editing pad
using the vertical pigtail #,
horizontal line —, and insert space
gesture L

Tap to correct it on the page and
continue checking.

3 Atany time you can tap . to close
the spelling checker.
(object) letter with S drawn on title line, spelichecker floating with first word it misspelled “traveling” in

editing pad tap on correct word
figure U6-17

USING THE GO COMPUTER GO CONFIDENTIAL
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FORMATTING TEXT
CHECKING YOUR SPELLING

You can start at any point in the document to check the spelling by drawing
an 5.

Instead of using the gesture to begin checking your spelling, you can also
choose Spell from the Edit menu to check the entire document.

While you’re using the spelling checker, you can display other alternatives and
skip words.

v Double-tap to put any alternative word in the editing pad and to display
further alternatives.

« Tap the translate button to skip a word without correcting it and continue
checking.

Adding a Word to the Dictionary

PenPoint refers to {Proximity dictionary} when it translates your writing and
checks your spelling. You can add words to a personal dictionary, such as
company names or acronyms, so that PenPoint will recognize them. You add
words to the personal dictionary from the spelling checker, proof sheet, or by
writing them in the personal dictionary which is stored in the Accessories
{palette}.

You add words automatically to the personal dictionary each time you tap the
translate button on the proof sheet or spelling checker to accept the word.

To see the words you’ve added to the dictionary, open the personal dictionary
in the Accessories {icon}. You can add to, delete, or edit the words in the
dictionary.

1 Tap to open the Accessories ficon}
Z Tap to open the personal dictionary

3 To view the list of words, flick the

page or tap the scroll arrows

4 To add a new word draw a caret A
and write in the new word

Delete a word by drawing a cross
out X over it

To edit words, draw a circle O to
open an editing pad and change it

there
(object) accessories icon with personal dictionary tapped; leader line to scroll arrows; caret drawn in and
new word added, word above it crossed out with delete gesture, word below it circled and in editing pad
figure U6-18

Read “Editing Text in Editing Pads” in this chapter to find out how to revise
text in the editing pad.

EDITING AND FORMATTING TEXT
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ADDING A SIGNATURE

Adding your Signature to a Document

In many kinds of documents you can add a signature to your correspondence
with the signature pad. Whatever you write on this pad appears untranslated, as
if you had written it directly on the page. You'll need a graphics printer to be

able to print your signature.

1 Toadda signature to a Text Editor

document, tap to select a location
in the document

Choose Signature Pad from the

Insert menu

Write your signature naturally, in
whatever style you normally use

To erase what you’ve written,
scratch it out 2

Move the pad by {??}

Resize the pad by dragging the
handle {??}

To delete a signature, select the
space above and below the pad and
choose Delete from the Edit menu

(screen) contract with | beam before “Richard”; (object) insert menu with Signature Pad selected

with signature pad inserted for Hopkins and signed by him

figure U6-19

Once you’ve added a signature to a document you can fax it or print it with a

graphics printer.

USING THE GO COMPUTER
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FINDING AND REPLACING TEXT

Finding Text

PenPoint can find a certain word or phrase every time it appears in a
document. If you wish it will also replace it with different text.

Although you can limit the scope of a search, most often you’ll probably want
to search one entire document.

1 To search the whole document,
draw an F on the title line

You’ll see the Find sheet

%2 Write in the text you want PenPoint
to find.

Ifit’s filled in from the last time
you searched the document, delete
the text by drawing a cross out X
on it and write in the new text, or
edit the text that’s there

3 Tap Find to find the next
occurrence of the text. Repeat this
procedure until the message in the
Status line tells you that the search
is completed

will pay eac mvoxce rom an approv d

i xn thxrty (30) days.

and your a.mstants?at FastPak Design are not and Z
>t be employees of New World Foods, Inc Thts is
' vv:étsmlcwforhlte Pl

n:)lsswslmn[mmltpwd pasadaiq [ posd_juaung[sauos R

4 Atany point you can tap Close to
close the sheet and end the search

You can also search a document by choosing Find from the Edit menu.

If PenPoint can’t find the text you've indicated, you’ll see the message End of
Document Reached in the Status field.

USING THE GO COMPUTER GO CONFIDENTIAL
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FINDING AND REPLACING TEXT

Replacing Text

Use the Find & Replace sheet when you want to replace the text you find with
other text.

At times you’ll want to stop at each occurrence to decide whether to replace it.
For example, if you’re replacing a word with another one, you might want to

check the usage in each sentence to make sure it’s correct. In this case you'll tap
Find and then Replace each time.

If you want to replace all occurrences of a word automatically throughout the
document, tap Replace All. For example, if you're revising a contract for a new
client, you can substitute the current client’s name for the old one.

% To search the whole document,
choose Find from the Edit menu

he designs and drawings
New World upon Paymentfo: .

| ALsoon [1poid_pasodaig] paia 1uaiino[stuaiod

You’ll see the Find sheet

%2 Tap the arrow on the title line to see
the menu for the Find & Replace

=y heet. Tap to display it.
o] sheet. Tap to display i

GO CONFIDENTIAL FINDING AND REPLACING TEXT
SEPTEMBER 26, 1990

3




FINDING AND REPLACING
REPLACING TEXT

3

g

TEXT

Wite in the text you want PenPoint

to find in the Find field.

Write in the replacement text in the
Replace field

Tap Find to locate the first
occurrence of the text

Tap Replace if you want to insert
the new text

Or, tap Replace All to replace every
occurrence automatically

If you don’t want to insert the text,
tap Find to locate the next
occurrence

Tap Find to continue the search
Repeat this procedure until the
message in the Status line tells you

that the search is completed.

Tap Close to close the sheet

If the text in either the Find or Replace fields is filled in from the last time,
delete the text by drawing a cross out X on it and write in the new text, or draw
a circle O over the text to open an editing pad and change it there. “Editing
Text in Labels, Document Titles, and Fields” in chapter 6 explains how to edit

text in fields.

USING THE GO COMPUTER
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FINDING AND REPLACING INFORMATION

Defining the Search

The search options on the Find & Replace sheet set the extent and direction of
the search and the attributes to look for, such as whole words or words whose
case matches exactly.

Setting the Search Range

You can determine the range of the search in several ways. Each time you
choose Find, PenPoint searches throughout the document and all the
embedded documents.

v To search a document from any point in the document, draw a F in the
body of the document. PenPoint searches from the place you drew the
gesture to the end of the document. To continue the search at the
beginning of the document, tap Find again

» To search a document without its embedded documents, tap Document
Only in the Search options

w To search a selection, select the text and draw an F over it

Setting the Position and Direction

In addition to telling PenPoint where to look, you can set the starting point and
direction of the search. For example, if you're at the end of a long document
and the text you want to find is in the last two pages, you can instruct PenPoint
to search from your current location backwards.

GO CONFIDENTIAL FINDING AND REPLACING TEXT
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FINDING AND REPLACING
DEFINING THE

Wasn't implemented at time of
capture.
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INFORMATION
SEARCH

To search from the current selection
to the end of the document, tap
Direction options and choose
Forward

To search from the current selection
to the beginning of the document,
tap Direction options and choose

Backward

To start the search at the last place
PenPoint found the text, tap Start

From options and choose Last
Match

To start the search at the top of the
document, tap Start From options
and choose Beginning

GO CONFIDENTIAL
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FINDING AND REPLACING INFORMATION
DEFINING THE SEARCH

Refiring the Search

PenPoint gives you several other ways to refine the search. For example, you can
tell PenPoint to locate only those instances where the text forms a complete
word. This is helpful when you want to find a word such as “pen” without
stopping for words such as “depend” and “peninsula.”

Finds the text if it has the same case
as the original text

Finds the text if it forms a whole
word

Replaces text using the case of the
original text

Replaces text with the case you used
in the Replace field

GO CONFIDENTIAL FINDING AND REPLACING TEXT
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The Table of Contents lists all the documents in your Notebook and lets you
organize them in relation to each other. You can find out more about them
with the Table of Contents menus, such as the Show menu which tells you the
document’s size and when you last modified it.

You can also organize the Notebook to suit your work habits by moving pages
from one location to another and by placing related documents in sections. To
further customize the Notebook, you can set preferences, such as the shape and
width of the character boxes in writing pads.

When you use the Notebook you’ll often work with more than one document
at a time. There are several ways to do this. Each method offers its own

advantages.

v The Table of Contents shows all the documents in the Notebook organized
by section, which makes it easy to identify and turn to the one you want

v Notebook tabs let you use a single tap to turn to a page from anywhere in
the notebook

v Page arrows in the title line navigate quickly from one page to another

« GoTo buttons let you move directly from one document to another
location within the same or different document.

USING THE GO COMPUTER GO CONFIDENTIAL .
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ORGANIZING THE NOTEBOOK

Seeing What's in Your Notebook

The Table of Contents lists all the documents and sections for the entire
Notebook in the order in which they appear. Page numbers refer to the page in

the Notebook where you can find the document.

Document titles appear in plain text
Sections appear in bold

Double-tap a section title to display
its contents. Double-tap again to

hide the document titles.

Icons tell you the type of document
you're using

Tap a section’s page number to turn
to its table of contents

screen TOC with callouts to section and document and icon; leader line to section that's closed with

doubletap gesture on it figure U8-1

Instead of tapping a section title to see what’s in it, you can choose Expand
from the View menu to display the titles. Choose Collapse to hide them.

Each section also has its own table of contents which works exactly like the one

for the notebook.

GO CONFIDENTIAL
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To see the documents contained in a
section, double tap .. its title. To float a
document or section, double tap .. its page
number.
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ORGANIZING THE NOTEBOOK

Finding Out More About a Document

The document option sheets and the Table of Contents Show menu give you
two tools for getting more information about a document, such as its size, the
date on which you created it, and the program with which you created it. The
Show menu shows you basic information about all the documents at once,
whereas the document options sheets give you more detailed information about
an individual document.

Using the Show menu

1 Tap to display the Show menu

2 Tap each kind of information you
want to see; tap again to hide it

Tap Tab Box to display the column
of tab boxes (tap to add or remove a
tab)

Tap Icon to show the program icon
Tap Type to see the program name

Tap Date to find out the date on
which you last modified the
document

Tap Size to tell how large the
document is in kilobytes (a kilobyte
contains approximately 250 words)

Partial screen of Show menu; screen of TOC with all options shown on TOC and callouts from Show
menu commands to each appropriate column. figure U8-2

USING THE GO COMPUTER GO CONFIDENTIAL
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ORGANIZING THE NOTEBOOK
FINDING OUT MORE ABOUT A DOCUMENT

Using the Document Option Sheets

The document option sheets supplement the information in Table of Contents.
Refer to them to see information such as the size of the document when it’s
active and to change such information as the page display.

% Turn to the document
Draw a check ¥ on the title line

3 Tap the arrow on the title line to see
the other option sheets and make
changes if necessary

partial screen of title line and upper portion of doc, check « on title line; access option sheet showing;
option menu displayed

figure U8-3

The Access sheet determines what areas of the page PenPoint displays. This is
also where you protect the document from being accidentally deleted or edited.
A Hot Mode option lets you speed up the time it takes to turn to a document.

Use the Document sheet to enter information about the document and to find
out when you created or last changed it. You can also find out how much space
the document occupies in the Notebook when you’re not using it (Filed Size)
and how much memory it takes up when you’re working with it (Active Size).

Refer to the Program sheet for information such as the version of the program
you’re using.

You can also open the document option
sheets by choosing About from the
Document menu. (Choosing About from the
Table of Contents displays the option
sheet for the Table of Contents.)

GO CONFIDENTIAL MANAGING THE NOTEBOOK
SEPTEMBER 26, 1990 5



ORGANIZING THE NOTEBOOK

FINDING OUT MORE ABOUT A DOCUMENT

Printing the Table of Contents

Sometimes it’s useful to have a list of the documents you keep in your
Notebook. You can do this by choosing Print from the Document menu and
printing the Table of Contents.

Before choosing Print, check to see if you've selected a document. If so, tap it
to deselect it or PenPoint will print the selected document rather than the list of
titles.

USING THE GO COMPUTER GO CONFIDENTIAL
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ORGANIZING THE NOTEB
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Sorting the Table of Contents

Commands in the Sort menu let you rearrange the Table of Contents by
criteria similar to the Show menu. Use the sort commands, for example, when
you want to list documents in order of size so you can decide which ones to

store outside of your notebook.

TOC sorted by size with Sort menu showing and size checked. figure U8-4

Tap the Sort menu, then tap:

4 By Page to display the documents
in the order they appear in the
notebook (the default order
unless you change it)

4 By Type to group the documents
by program

4 By Size to arrange the documents
according to the amount of space
they occupy in your Notebook

4 By Name to list the documents

alphabetically

4 By Date to put the documents in
order by the date you last
modified them

Sorting documents rearranges their order
in the Table of Contents, but not their page

location in the notebook.

GO CONFIDENTIAL
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ORGANIZING THE NOTEBOOK

Rearranging the Notebook

You can rearrange the notebook by moving pages and placing related

documents in sections. Rearranging pages changes their physical location in the
notebook.

Moving Pages

The easiest way to move pages from one place to another in the notebook is by
using the Table of Contents.

¥ Tap to turn to the Table of Contents

2 Press hold to select a document or
section and then drag it where you
want it to go.

PenPoint inserts the new document
where you lift your pen.

screen TOC with Section titlied New Bottle Design moved so it follows Proposed New Products. figure
us-5

USING THE GO COMPUTER GO CONFIDENTIAL
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ORGANIZING THE NOTEBOOK
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Grouping Documents into Sect

. Crea

You can organize your computer notebook, as you would a paper notebook, by
placing related pages together in sections and subsections.

ting a Section

GO CONFIDENTIAL
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% Turn to the Table of Contents

% Draw a caret A

2

+> Choose Create Section from the

Create menu

PenPoint inserts the new section
where you drew the caret

screen TOC caret above Sales; Create Section tapped on Create menu. figure 8-6

If you choose the Create Section command without first selecting a location in
the Table of Contents, PenPoint makes the section the last section of the
Notebook.

To rename a section, choose Rename from the File menu, or draw a circle O on
the name to change it in an editing pad.

When you create a section, PenPoint automatically inserts a section divider
which lists the documents contained in it and works exactly like the notebook
Table of Contents.

To delete a section draw a cross out X on
the section title. But if you intend to use
the section again, back it up to a disk
before deleting it from PenFoint.

MANAGING THE NOTEBOOK
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ORGANIZING THE NOTEBOOK
GROUPING DOCUMENTS INTO SECTIONS

Moving a Document into a Section

Once you set up a new section you can create documents there or move existing
documents into it.

To create a new document in a section, doubletap the section title to expand it,
tap to select a location (tap Empty if there are no documents), and then
choose a piece of stationery from the Create menu.

To move a document into a section,
drag the document to a location
within the section.

To move a document out of a
section, drag the document outside
the section. (Lift the pen when it’s
aligned with the left margin)

screen TOC with new section above Sales renamed District Sales Reports and the document Sales by
Region moved into it; figure 8-7

Creating a Subsection

Sections can contain subsections. To create a subsection, open a section, select
a location in it, and choose Create Section from the Create menu.

Subsections work the same way sections do. Each subsection has its own table
of contents which lists the documents contained it. This information is
repeated in the section and notebook Table of Contents.

You can make a section a subsection by moving it into another section. For
example, you might move a section you’d created for a prospective client into a
section for new clients. '

You can also promote a subsection to a section by selecting it and moving it
outside the section to another location on the Table of Contents.

USING THE GO COMPUTER GO CONFIDENTIAL
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MOVING AROUND THE NOTEBOOK

Turning to a Fage

The Table of Contents displays all the documents contained in the Notebook.
From it you can use gestures or the View menu commands to turn to any page
in the notebook or float one over the Table of Contents.

Turn to a page by tapping the

document’s page number, or

Float a page by double-tapping the
page number

partial screen: TOC with leader line to page number partial screen TOC with double-tap gesture drawn
on letter's page number and letter fioating on TOC. Figure U8-8

Before floating a document, first select
the option for floating documents on the
Misc option sheet in Preferences. You only
need to set this option once to be able to
float documents any time you use the
Notebook.

GO CONFIDENTIAL MANAGING THE NOTEBOOK
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MOVING AROUND THE NOTEBOOK
TURNING TO A PAGE

Instead of using gestures to turn to or float a page, you can choose equivalent
commands (Turn to and Bring to) from the View menu. Select the title in the
Table of Contents and then choose the appropriate command.

If you’re not working on the Table of Contents you can thumb through the
notebook by pressing the arrows near the page number or drawing flicks in the
title line.

Tap the left arrow to go back to the

previous page

Tap the right arrow to turn to the
next page

Press the arrows to flip through the
pages

(object screen of title line) leader lines to arrows figure 8-9

You can also draw flicks in the title line to turn to the next page (flick left) — or
go back to the previous page (flick right) —. Think of this as thumbing through
a notebook; you turn a page to the left to see the next page, and to the right to

go back to the beginning. A double flick right = turns to the Table of Contents.

USING THE GO COMPUTER GO CONFIDENTIAL
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MOVING AROUND THE NOTEBOOK

Using Notebook Tabs to Mark Fages

GO CONFIDENTIAL

Tabs offer a quick way to identify a page and turn to it or float it over any other
page in the notebook. You can attach a tab to any document or section by
drawing gestures or by displaying the column of tab boxes and tapping its tab
box.

Attaching and Deleting Tabs

Turn to the Table of Contents

%2 To attach a tab, draw a T on the
document or section title

To remove it, draw the T again
screen TOC, T drawn on section title figure 8-10

When you attach a tab, the Lombard automatically labels it with the document
title.

Since a long document title won’t be fully shown on the tab, you can rename
the tab with a shorter or more useful title. To rename a tab, draw a circle O on
the text to display the title in the editing pad and change it there.

Renaming a document changes its tab label. However, if you change the
document title after editing the tab label, PenPoint doesn’t automatically
change the tab label.

For details on editing tab labels, see “Editing Labels, Document Titles, and
Fields” in chapter 6 (Editing and Formatting Text).

If you're working on a page other than the
Table of Contents, you can also attach a
tab by drawing the T on the document title
line.

MANAGING THE NOTEBOOK
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MOVING AROUND THE NOTEBOOK
USING NOTEBOOK TABS TO MARK PAGES

Attaching Several Tabs

In managing the notebook, you may find it more convenient to attach and
remove several tabs at once.

1 Turn to the Table of Contents

2 Tap the Tab Box command on the

Show menu

A checkmark indicates the page has
atab

To attach a tab, tap inside the box
To remove it, tap again

(object screen) Tab command selected on Show menu; (screen) TOC with tab boxes; leader line to box
with checkmark to show page has a tab; tap gesture on empty box figure 8-11

USING THE GO COMPUTER GO CONFIDENTIAL
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Displaying Tabs

MOVING AROUND THE NOTEBOOK

USING NOTEBOOK TO MARK PAGES

When you have more tabs than can fit along the edge of the notebook, they

appear overlapped.

To see the hidden labels, draw flicks on the tabs. To see all the tabs at once, flick

left — on any tab. You'll see the tabs in several rows.

Flick left — to see all the tabs at
once. The row of tabs will collapse
again as soon as you do anything
else.

To move the overlapped tabs to the
top, double flick up E

To move the overlapped tabs to to
the bottom, double flick down }

To see an overlapped tab:
Flick up on the tab above it

Or, flick down on the overlapped
tap

several diagrams of a row of tabs with each gesture made on same tab; show the different results figure

8-12

GO CONFIDENTIAL
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MOVING AROUND THE NOTEBOOK

N

Using GoTo Buttons to Move Between Fages
J g

A GoTo button lets you hop from one document to a second document. It
provides a quick way to move between two pages without using the Table of
Contents.

1 Start from the document from
which you want to jump

2 Float the Table of Contents by
double tapping its tab

3 Tap to select the document you
want to jump to

4 If you select the document title,
the GoTo button takes you to the
top of the document. To go to a
specific place within the
document, float it and tap to
select a location.

% Draw a go to button @ on the first
document where you want the
button

PenPoint places a Goto button
there and labels it with the title of
the floating document

(screen) letter with TOC floating on it and “Complaints to Act On” selected in TOC (screen) letter with
goto button gesture drawn after sentence “The executive never got a chance to try our product” figure
us-13

GoTo buttons work like page numbers in ti
Table of Contents:

Tap the button to turn to the linked
document, or

Double-tap to float the linked document
over the first.

USING THE GO COMPUTER GO CONFIDENTIAL
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MOVING AROUND THE NOTEBOOK
USING GOTO BUTTONS TO MOVE BETWEEN PAGES

To make a link to an embedded document, float the document that contains
the embedded document, draw a plus + on the embedded document’s icon to
select it, and then draw a go to button @ on the first document.

You can insert several buttons in a document and have each one turn to a
different page or to the same page. If you have a long document, however, you
may be working on a page that doesn’t show the GoTo button. In this case, you
might find it more useful to place the button in the cork margin where it’s
always available. To find out how to use the cork margin, read “Customizing
the Notebook” in this chapter.

To delete a GoTo button, draw a cross out X over it. To move it, draw a plus +
on the button to select it, press then drag it to a new location.

You can rename the button label by drawing a circle O on it and editing the
text. See “Editing Labels, Document Titles, and Fields” in chapter 5 (Editing
and Formatting Text).

When you print the document, PenPoint
prints the text on the button. Move the
GoTo button to the cork margin to avoid
this.

GO CONFIDENTIAL MANAGING THE NOTEBOOK
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CUSTOMIZING THE NOTEBOOK

Setting Preferences

Your Notebook comes with certain options preset, such as the screen layout.
You can change these options in the Preferences {notebook} on the bookshelf.

Preferences includes options for:

Writing in uppercase and adjusting the size and shape of the writing pads
Aligning the pen

Setting the time and date

Choosing a left-handed or landscape layout

Choosing a system font and a font for text in fields

Enabling floating, zooming, and the warning beep

AU N N N AN

Lengthening or shortening the time interval between doing something
drawing a gesture, pressing something, writing and PenPoint interpreting it

If more than one person uses the Notebook, you can have PenPoint remember
these changes. To find out how to save your preferences read “Installing
Programs and Devices” (chapter 3).

Choosing a writing style and aligning the
pen are covered in “Writing in the Noteboc
(chapter 5).

USING THE GO COMPUTER GO CONFIDENTIAL
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CUSTOMIZING THE NOTEBOOK
SETTING PREFERENCES

Setting the Time and Date

Programs and accessories that display the time and date refer to the settings on
the Preferences option sheet.

To reset the time:

1 Tap the Preferences icon on the
bookshelf

2 Tap the arrow on the title line to see
the other sheets and tap to choose
the Time sheet if it’s not displayed

Write in the new Hour, Minute,
Second

Tap to choose a time period
Tap to choose a Time Zone
Tap to choose a Time Format to
display the time in 12 or 24 hour

intervals

2 Tap the appropriate button

(object) Preferences icon; Pref notebook showing Time sheet with leader line {?} to am/pm figure U8-14

If you change time zones, you don’t need to
reset the time. Choose a time zone and
PenPoint automatically calculates the new
time.

GO CONFIDENTIAL MANAGING THE NOTEBOOK
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CUSTOMIZING THE NOTEBOOK
SETTING PREFERENCES

To change the date:

1 Tap the arrow on the title line to see
the other Preferences sheets and tap
to choose the Date sheet if it’s not

displayed
Write in the new Month, Day, Year

Tap to choose a Date Format
(object) Preferences icon; Pref notebook showing Date sheet date format options displayed to show the
different choices. figure U8-15

Turning On the Warning Beep

When PenPoint displays a confirmation or error message, you need to respond
to the message on screen or PenPoint can’t carry out your command. As a
further signal, you can have PenPoint sound a warning beep when it displays
the message.

To turn on the warning beep, display the Misc sheet in Preferences and tap On.

..................................

PenPoint uses a system font to display information such as menu commands,
titles on the Table of Contents and tabs, and a field font for the information
you enter in writing pads and fields (on option sheets and forms).

You can change the style of each font. Whatever size you choose, however,
applies to both fonts.

1 Tap the Preferences icon on the

bookshelf

2 Tap the arrow on the title line to see
the other sheets and tap to choose
the Fonts sheet if it’s not displayed

Tap to choose a font size

Tap to choose a System and Field
font

(object) Preferences icon; Pref notebook showing Fonts sheet figure U8 16

Choose text fonts for documents from tl
Text option sheets.

USING THE GO COMPUTER GO CONFIDENTIAL
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CUSTOMIZING THE NOTEBOOK
SETTING PREFERENCES

Choadsing a Screen Layout

PenPoint offers several screen layouts to accommodate different writing tasks
and writing preferences.

1 Tap the Preferences icon on the
bookshelf

2 ‘Tap the arrow on the title line to see
the other sheets and tap to choose
the Layout sheet if it’s not displayed

% Tap the appropriate option

Choose Landscape when you're
working on a drawing or a task that
requires more horizontal than
vertical space on the page

Choose the layout that corresponds
to the hand you write with

(object) Preferences icon; Pref notebook showing Layout sheet figure U8-17

GO CONFIDENTIAL MANAGING THE NOTEBOOK
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CUSTOMIZING THE NOTEBOOK

Moving Items on the Bookshelf

You'll probably find that you use some items on the bookshelf more frequently
than others. You can move the ones you use less often to a second shelf and also
rearrange their order in a way that’s more convenient.

For example, once you’ve customized the notebook and the Create menu, you
might move the Preferences icon and Stationery notebook to the second shelf
and put in their place the In and Out boxes you use daily to send and receive
faxes.

1 Drag the handle up

2 Press hold the icon until you see the
animated line, and then drag it to
the second shelf

To hide all the bookshelf items,
drag the handle down until it covers
both shelves

(partial screen) lower part of TOC with second book shelf revealed, leader line to handle; Preferences
icon being moved to second shelf. figure U8-18

'To move an icon to another position on the shelf, press hold and then drag it to
the new position.

USING THE GO COMPUTER GO CONFIDENTIAL
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CUSTOMIZING THE NOTEBOOK

Customizing the Help Notebook

When working with the Help notebook, you may find it useful to annotate it
with tips and information you’ve discovered while working with your GO
Computer.

To add a new document, draw a caret A on the Table of Contents where you

want to the document to go and choose a piece of stationery from the Create
menu.

If you no longer need to refer to a document, you can delete it by drawing a
cross out X on its entry in the Table of Contents.

GO CONFIDENTIAL MANAGING THE NOTEBOOK
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CUSTOMIZING THE NOTEBOOK

Using the Cork Margin

The cork margin is an area at the bottom of the document where you can put
GoTo buttons, new or embedded documents, and accessories. You have access
to things you've placed there no matter where you are in the document.

PenPoint doesn’t print what’s on the cork margin, so you can move buttons and
closed embedded documents there when you don’t want their icons or labels
printed.

The cork margin is always part of a
document, but it’s usually hidden
from view

To display it, draw a C in the

document title line

Draw a C again to hide itand
everything on it

{screen) contract with C drawn in title line; each of these elements aiready in the cork margin: istitem
should be new doc labeled Notes; 2nd item should be an embedded doc (the package letter); 3rd item
goto button labeled "technical” (goes to word technical in item #1 of contract); 4th item goto button to
Send List; 5th item calculator

You can also show the cork margin by
drawing a check ¥ on the document
title line to display the document option
sheets and selecting Cork Margin on
the Access sheet.

USING THE GO COMPUTER GO CONFIDENTIAL
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CUSTOMIZING THE NOTEBOOK
USING THE CORK MARGIN

Use the cork margin when you want to annotate a document. To insert notes
and instructions in the cork margin, draw a caret A to display the Create menu,
and then tap to select a new piece of stationery.

You might also move an existing document, such as a To Do list, to the cork
margin so you can update it while working on the current document. To put it
in the cork margin, copy or move it from the Table of Contents.

Place GoTo buttons in the cork margin to turn quickly to parts of the
document you want to see without having to scroll through the document to
find them. To insert a GoTo button in the same document, select a word and
draw the gesture for a GoTo button @ in the cork margin. To insert a GoTo
button to turn to a different document, select the document in the Table of
Contents, and draw the gesture for a GoTo button @ in the cork margin.

To have easy access to an accessory, such as the calculator, copy the icon for it
to the cork margin.

To change the location of a GoTo button in
the same document, select a new word and
triple tap the button. FenFoint changes the
label to reflect the new location.
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